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Introduction

Web accessibility is essentially about providing information on websites and technologies that can
be equally accessed, used and understood by everybody. This inclusive practice is aimed at
various user audiences (such as visually impaired, blind, deaf and hard of hearing people, people
with impaired physical skills or with cognitive impairments, but also elderly people or people with
different native languages), and includes technical devices for navigating the Internet as well.
Apart from the public sector, business companies, too, increasingly recognise the value of

accessibility as a quality asset of their online communication.

In Germany, the BITV 2.0, the revised version of the German Ordinance for Accessible
Information Technology, has been in force since September 22, 2011." Specifying the technical
details of the requirements of §11 Disability Equality Act (BGG), the ordinance obliges the
authorities of the Federal Administration - including the Federal Ministry for the Environment,
Nature Conservation and Nuclear Safety (BMU) and its Federal agencies to use accessible web
technologies for offering their content online. Ldnder authorities have their own regulations, which

are generally based closely on the federal BITV.

The BITV 2.0. transposes the International Web Content Accessibility Guidelines (WCAG) 2.02 by
the World Wide Web Consortium (W3C) into national German law. The ordinance explicitly
addresses the WCAG criteria of level A (minimum requirements) and AA (further requirements),

declaring these as compulsory.
Accessibility and PDF

The BITV 2.0 does not only cover websites, but all embedded applications, media and file
formats, including PDF documents. For many years now, PDF (Portable Document Format) has
been one of the most widely used file formats on the Internet. Consequently, PDF today is an
integral part of everyday digital life. The PDF format is usually used to present information across
all kinds of different platforms and devices while at the same time preserving its original layout
unchanged. Every user receives the document layout exactly as the author intended it to look
like.

Accessibility, in turn, demands the very opposite: each and every user shall be able to adapt the

presentation of content such as text and images to their individual needs.

' http://www.gesetze-im-internet.de/bitv_2 0/BJNR184300011.html
2 http://www.w3.org/TR/IWCAG20/
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These web accessibility requirements include:

o Typeface adjustments, e.g. font resizing,

customising colour representation and / or contrast of text and background,

operation / navigation only with the keyboard,

preservation of reading order in linear media,
e automatic language recognition through voice output.®
The concept of tagged PDF

In order to meet the requirements mentioned above, web content needs an internal structure
assistive technology (AT) can build on. The basic idea of the tagged PDF approach is to separate
content from layout to make the PDF file accessible for AT such as screen readers.

A PDF file that is properly marked up with tags and bookmarks helps users who rely on certain
accessibility features to navigate through the document. Visually impaired users can read and
navigate through properly tagged PDFs by software or output in Braille and can adjust font size

values to their personal liking.

tagged PDF makes PDF documents machine-readable. This allows an accessible document to
be read and customised to individual needs. What's more, a PDF that is semantically enriched by
structural tags also qualifies for search engine optimisation (SEO) purposes and better output on

mobile devices.

In a nutshell:
An accessible PDF document retains the original visible layout, but it is enriched by additional
information such as invisible structure elements (document structure tags, usually referred to as

"tags"), navigation links, or bookmarks.

If you as an author, designer or editor, are involved in the process of creation, design, online
distribution and use of PDF documents, it is your responsibility to ensure that the resulting
documents comply with accessibility requirements. Accessibility issues must be considered

effectively from the very beginning of the conception and design process.

This guide is intended to give you an initial technical introduction and guidance on how to prepare
accessible PDF documents in Microsoft Word and remediate the resulting PDF documents in

compliance with the current standards.

3 http://www.einfach-fuer-alle.de/artikel/pdf-barrierefrei-umsetzen
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2 Standards and legal provisions

BITV 2.0 represents the legal basis for all publications to be published on the BMU website. This
implies that all PDF documents created on behalf of the BMU and intended for publication on a

web site of the Ministry are subject to the requirements of this ordinance.

BITV 2.0 applies across technologies, thus making accessibility requirements equally binding for
technologies as diverse as HTML, video formats or, of course, PDF. In practice, different aspects
and working steps come into play - depending on the technique. However, the ordinance does
not offer concrete instructions for fulfilling the respective criteria. For contractors, beneficiaries
and service-providers there are additional technical specifications available on how to produce

accessible, BITV 2.0-compliant PDF documents.

The PDF 1.7 Specification

Creating an accessible PDF is all about mapping the document’s content to a correct tag
structure. The basic rules and structure elements for tags in PDF are defined and explained in the
official PDF specification, which sets formal structural rules for PDF documents. The concept of
tags has been in use since the PDF 1.7 specification, which was released as ISO standard
32000-1 in 2007 and is available online for free.* An annotated overview of the officially defined

structural elements can be found in Chapter 6.

Please note:

In 2017, the new PDF standard 2.0 was released as an ISO standard. This also brought about
some innovations in the area of accessibility. In the context of this user guide, however, these
aspects shall be mentioned in passing only, as the PDF/UA standard in its currently applicable
version PDF/UA-1 refers to PDF 1.7. The release of the successor standard PDF/UA-2, which is

planned to incorporate the revised structure concepts of PDF 2.0, has not been announced yet.

2.2. The PDF/UA Standard

Conventional web accessibility tests do not cover all the technical PDF details necessary to
achieve full PDF accessibility. Currently, a specifically designed procedure to test PDF for BITV
2.0 compliance does not exist. How a PDF should be built to conform with BITV 2.0 is therefore
technically neither clearly defined nor transparently verifiable. In the past, this circumstance made
it difficult for Ministry and service providers alike to easily create and check the accessibility of
PDF files.

4 see chapters 10.7 und 10.8 in http://www.adobe.com/content/dam/Adobe/en/devnet/acrobat/pdfs/pdf reference 1-
7.pdf#page=883
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The BMU therefore has decided to introduce PDF/UA (UA = Universal Accessibility) as additional
standard for accessible PDF: Since January 2017, all PDF documents published on the BMU
website must meet the requirements of PDF/UA-1 (ISO 14289-1) - in addition to the still-valid
provisions of BITV 2.0.

PDF/UA closes a normative gap between web and PDF technology: it clarifies and simplifies the
PDF requirements to meet BITV 2.0 and WCAG 2.0 respectively by adding technical, PDF-
related provisions for achieving full accessibility. The PDF/UA standard was developed by the
PDF/UA Competence Center of the PDF Association, who foster and promote international

standardization of the PDF technology.

The requirements of the PDF/UA standard not only apply to the PDF file format (documents), but
also to conforming assistive technology (AT) and PDF reading or processing software. This is to
ensure that a PDF/UA-compliant PDF document read with a PDF/UA-compliant device offers the

user the best possible accessibility experience.

The basic testing procedure for PDF/UA compliance is the so-called Matterhorn Protocol 1.0.2.
For the technically verifiable criteria a free testing tool is available - the PDF Accessibility Checker
(PAC 3).

In 2014, the PDF/UA standard has been translated into the German DIN ISO 14289-1 standard.

The PDF/UA standard is based on the recommendations and guidelines of WCAG 2.0 and PDF
specification 1.7 (see footnote 4). Following the release of the new PDF 2.0 standard, the
PDF/UA standard is currently under revision to reflect the changes in the future. Until the release
of the revised version, which is expected around 2019 / 2020, the old PDF specification PDF 1.7

continues to form the basis for PDF/UA.

2.3. PDF/UA requirements

A PDF document is accessible in accordance with the PDF/UA standard if
1. itis directly accessible based on its tag structure
2. all the requirements and conditions of the PDF/UA standard are met and
3. the test according to the Matterhorn Protocol is successful.

The following conditions must be met in all PDF/UA-1 documents:5

5 https://www.pdflib.com/fileadmin/pdflib/pdf/whitepaper/Whitepaper-Technical-Introduction-to-PDFUA.pdf
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The document must be tagged. While PDF 1.7 includes some requirements regarding the
nesting and relationship of different types of structure elements, PDF/UA-1 extends and

clarifies these rules ().

All fonts used in the document must be embedded (except fonts for invisible text, e.g.
OCR results).

Some layer options are not allowed.
Reference XObjects for external page content (as used in PDF/X-5) are not allowed.

The document title must be specified in the document’s metadata

When creating the structure hierarchy for PDF/UA-1, several semantic aspects must be obeyed.

These are discussed in more detail in Chapter 4.2. For more information please see the PDF/UA

resources on the PDF Association's website.®

2.4. Process steps

The following major steps are required to adapt or remediate a PDF document to comply with the
PDF/UA standard:

Creating a clear tag structure to define content in a comprehensible reading order;
Standard-compliant mark-up of heading, paragraph and list elements;

Purposeful and structured use of tables with header cells and connected cells;
Creating semantically correct bookmarks;

Explaining acronyms and abbreviations at the first occurrence and listing them in a

glossary;
Inserting meaningful alternative text in graphics, images and formulas;
Keyboard-operable hyperlinks with speaking link text or alternative text;

Setting the document’s default language, and, if applicable, identifying all language

changes within the document (paragraph-level);

Adding a PDF/UA Identifier to clearly indicate standard compliance to assistive software.

For tagging and remediating the PDF file, it is recommended to use the licensed Adobe Acrobat

Pro DC software, which offers many comprehensive features for editing PDF files. Acrobat and a

certain amount of experience help to produce reliably accessible results. In addition, starting with

8 https://www.pdfa.org/resource/
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the version of Adobe Acrobat Pro XI, the software comes with an extended range of remediation
functions and a user-friendly user interface compared to its predecessor versions.

This manual offers instructions on how to create and remediate accessible PDF documents using
the Adobe Acrobat Pro DC version.

Please note:

Even if the Adobe Acrobat PDF Maker plug-in for MS Word produces fairly good results, the
software does not deliver PDF/UA-compliant structures by its own, which means that the resulting
PDF still requires further remediation to close the gap to full compliance. Combining Acrobat with

PDF/UA-compliant software is highly recommended (see also Chapter 8).

2.5. Relationship between BITV 2.0 and PDF/UA

The PDF/UA standard clarifies BITV 2.0 provisions but does not substitute them. There is a large
overlap between the two sets of rules. PDF/UA imposes additional requirements beyond BITV

2.0, which, if consistently implemented, significantly improve BITV 2.0 conformance.

The requirements of BITV 2.0 include some aspects that frequently occur in PDF documents but
are not addressed by the PDF/UA standard since they are not of technical nature or do not

specifically apply to the PDF file format. However, these apply to each and every PDF document:

» Colour should not be used as the only means of conveying information. (Annex 1 to § 3 (1):
1.4.1 Colour)

+ Provide enough contrast between text and background: " The visual presentation of text and

images of text has a contrast ratio of at least 4.5:1" (Annex 1 to § 3 (1): 1.4.3 Contrast)

» Navigation without keyboard traps: If keyboard focus can be moved to a component of the
page using a keyboard interface, then focus can be moved away from that component using
only a keyboard interface, and, if it requires more than unmodified arrow or tab keys or other
standard exit methods, the user is advised of the method for moving focus away. (Annex 1 to
§ 3 (1): 2.1.2 No keyboard trap)

In short: all documents that are produced on behalf of BMU are to meet the following legal

requirements:
» The provisions of BITV 2.0 apply without restrictions.

» All technical criteria listed in the PDF/UA-1 standard are to be fulfilled as well (as far as

applicable).

» For all aspects of accessibility that are not specifically addressed by PDF/UA-1, the
requirements of BITV 2.0 apply.
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Detailed information, instructions and examples of the BITV 2.0 requirements can be found in the
comprehensive online guide BITV-Lotse, published in German by the Federal Ministry of Labour

and Social Affairs.
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3 Making documents accessible in MS Word

3.1.

There are some simple design principles and steps to take in creating word documents to make
sure that everyone can access them. The following instructions and illustrations are based on
Microsoft Word 2013. The practice in older or more recent software versions may vary, but the
basic steps are comparable.” Please note that this chapter’s additional illustrating images and
screenshots were taken from the original German-language manual and have not been translated

to English.

General preparations

When designing a document, always make sure layout provides enough contrast between text
and its background to meet BITV guidelines so that it can be read by people with moderately low
vision. This requirement applies to all fonts and design elements. For regular font size, the
contrast between font colour and background must be at least 4.5:1. Several free software tools
such as the Colour Contrast Analyser® can assist you in evaluating the conformance of your

colour combinations. Logos are excluded from the requirements for contrast.

Sprache ?
Ausgewahiten Text markieren als:
-
& Englisch (U5A)
Afrikaans
Albanisch
s Amharisch

Arabisch (Agypten)
Arabisch [Algerien)

Arabisch (Bahrain) v
Alle Korrekturhilfen verwenden automatisch die Worterbucher
der ausgewahlten Sprache.

[ Rechtschreibung und Grammatik nicht prafen
Sprache automatisch erkennen

Als Standard festlegen Abbrechen

ETE13VON73  14015WORTER  DEUTSCH (DEUTSCHLAND)

Make sure the default document language is set correctly. If your document contains content
written in multiple languages, all language switches must be appropriately indicated. Select the
text passage and change the language displayed on the horizontal bar at the bottom of the

screen.

The meta information can already be included in the document properties in Word. From the
angle of accessibility, it is particularly important to provide a correct document title to allow users

of screen readers to identify the file on the local desktop.

7 For more details on how to make Word documents accessible for people with disabilities see
https://support.office.com/en-us/article/make-your-word-documents-accessible-to-people-with-disabilities-d9bf3683-87ac-
47ea-b91a-78dcach3c66d?ui=en-US&rs=en-US&ad=US

8 The Color Contrast Analyser can be downloaded from https://developer.paciellogroup.com/resources/contrastanalyser/
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Eigenschaften -

D Dokumentbereich anzeigen

0: Eigenschaften Gber dem Dokument
anzeigen und bearbeite

Erweiterte Eigenschaften
— | Weitere Dokumenteigenschaften
anzeigen

sie..

Kommentare Kommentare hinzufag...

The document properties can be accessed via the File tab > Info> select Properties from the
menu. There, select "Show Document Panel" to enter the document title and author into the

appropriate fields.

3.2. Principle of structuring

Structure is the key to accessibility. On the one hand, this implies that clear language and a
meaningful and consistent organisation of the content lay the foundation of an accessible
document.

On the other hand, structure has a technical dimension as well: Starting with Microsoft Office
2000, it is possible to transfer structural information from a Word document to a “tagged” PDF
document. For writing the document in Word, this means: Each content element must be explicitly
assigned a format that reflects its function. The formatting is transferred as so-called "tags" into
the PDF file which form the hidden, structured representation of the PDF content that is
presented to screen readers. Typical types of content are, for example, headings, standard text

paragraphs, tables, or lists.

3.3. Using styles

A style is a set of formatting instructions. It is imperative to use styles for formatting each item in
the Word document, such as headings (ordered by levels), paragraphs, captions, footnotes, and
SO on.

Example: To apply a heading style to a portion of text, highlight the desired text and click Home >

Styles. Select the desired level heading style from the Styles gallery or the Styles pane.

[+ = s Dokumentl - Word ? E- x
|smp:r | ENFOGEN  ENTWURF  SEITENLAYOUT — VERWEISE  SENDUNGEN  UBERPRUFEN  AMSICHT ~ ADDANS  PDF Erik Rauchstein -
Y
3 I = = " sl m S
0 l Calibri (Texth - |11 A A | Al 455 [ | 8] | aapboene | asabcenc AaBbC( Assbce AGBI al
MIE

Einfagen - FKU-ax, | A-¥-A- E===|=- 8- . T Standard | T Kein Lee... Uberschrif... Uberschrif. Titel =

Zwis] o Absatz ] Farmatvorlagen

1.Klicken Sie auf den T -
Reiter Start. *

2.Klicken Sie auf die
gewiinschte Formatvorlage.
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Word 2013 provides insight into all the document’s current styles at Home > Styles. For an
overview of all the styles used in the document, you can display the entire dialog box via the
arrow icon. Ensure all heading styles are in the correct order. Use the navigation pane to view

and edit the document’s organisation: View > Show group > Navigation Pane.

3.4. Customising styles

Predefined standard styles may need to be modified to suit the desired document design (font

size, font type, etc.). For each recurring design, set up individual custom styles.

To customise existing styles in Word, select the text area you want to apply a particular style to

and choose a default style from the Styles task pane or the Styles gallery.

EH SO - Dokumentl - 7 ELh— ST

wmr Jesrooed 1-Klicken Sieauf SENDUNGE]2.Kllcken Sie auf Formatvorlagen. | S
den Reiter Start.
oL Calib i =0 ST e [ . i Suchen -
N alibri (Textk - | LT 7 5 = TamE e (EEE | AaBbCeDe AaBbceDde AgBbC( S

. b wac £rs

fnfigen o | F XK U -amn X |A-P-A- \BE===(E- b5 T Stendard | 1 Kein Lee... Oberschrif., [l e i‘; o

wischenabl.. Schriftart i Absatz n Formatvoriagen Bearbeiten Datenschutz |~

3.Wahlen Sie die zu @nderne Formatvorlage
aus und klicken Sie auf den Pfeil.

Formatvorlag... ™ %

Standard sktualisieren, um der Auswahl zu entsprechen

|4.Klicken Sie auf Andern. |—>|4-‘ Andern... ]

Alles markieren: (Keine Daten)

Alles entfernen: (Keine Daten)

Aus dem Formatvarlagenkatalog entfernen
Uberschrift 7 Ly

Select the style you want to change, click the arrow to open the menu and choose Modify.... In
the following Modify Style dialog box you can change the formatting for your style (e.g. font,

paragraph etc.). Click OK to save your changes.

For more details on different styles types, please check with Microsoft's Word help center or

another in-depth user’s guide.

3.5. Further process steps

3.5.1. Spacing between paragraphs

Be sure to avoid pressing the Enter key to create additional space between paragraphs. Instead,

use your styles properties to define and edit spaces between paragraphs.

Procedure:
Highlight the element which you want to define the spacing for. Proceed as described above to
modify the style.
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spieltext Beis .
[ Jeee——{2Klicken Sie auf Absatz.
Tabstopp...
Rahmen.
Sprache... (Calibri), Links

Bositionsah ., Abstand
Eosiionstatime s ymatvorlage: Im Formatvorlagenkatalog anzeigen

Nummerierung

Tastenkombination... wufdgen
Texteffekte. :ue auf dieser Vorlage basierende Dokumente
l 1.Klicken Sie auf Format. Abbrechen

In the Modify Style dialog box, select the Paragraph from the Format drop-down menu (bottom
left). In the Indents and Spacing tab, enter appropriate values for Before and After under Spacing.
These values will be applied to all instances of this style in the entire document.

It may be necessary to create multiple styles with different spacing to accommodate the
combination of different formats, e.g. a header may be followed by a standard paragraph or a

table and might require different spacing values for each case.

3.5.2. Creating numbered headings

To create numbered headings, you can use Word’s built-in Numbering function.

Brimninlbeus Baimnislbavt Beigpie|text Beispieltext Beispieltext Beispieltext Beispieltext Beispieltext
Schriftart... spieltext Beispieltext Beispieltext Beispieltext Beispieltext Beispieltext
A spieltext

Tabstopp..

Rahmen...

Sprache... [Calibri), Links

1, Abstand
Positionsrahmen... =

ImF
<—| 2.Klicken Sie auf Nummerierung. |
Tastenkombination... :uftgen
Texteffekte. :ue auf dieser Vorlage basierende Dokumente

[comat=_| |-<—|1.Klicken Sie auf Format.l ok Abbrechen

Select the desired heading style and go to Styles >> Modify.... In the window that opens, click
Format > Numbering.

3.5.3. Textin columns

To format your text in multiple columns, never resort to inserting layout tables, but always use the
built-in function. It can be accessed via the ribbon Page Layout > Columns > More Columns....

<—| 1.Klicken Sie auf den Reiter Seitenlayout. |
EINFUGEN ENTWURF SEITENLAYOUT VERWEISE
I (T

E Umnbrach Abstand L&
4 " x B (W
| ERRTES E@ﬂm-l 2.Klicken Sie auf Spalten.l : b
& . P Silbentrennung %
ite ein o ) Absatz ) Anordnen
Spaltel Spalte2
T 3.Klicken Sie auf Weitere Spalten. |

In the Columns dialog box, select the number of columns under Presets.
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If you want only part of the document to be displayed in a, say, two-column layout, select Apply

to: >> This point forward to insert a section break.

Spalten

Voreinstellungen

X

Eine Zwei Drei Links Rechts
Spaltenanzahl: |2 = [¥] Zwischenlinie
EBreite und Abstand Vorschau

Spalte: Breite: Abstand: —_—
H Lo B

|¥| Gleiche Spaltenbreite

Ubernenmen far: || Gesamtes Dokument |Z| Neue Spalte beginnen

Once you have inserted your multicolumn content, go back to the Columns dialog box, choose
the One column format and again select “This point forward”, and your document will return to the

default single-column format.

3.5.4. Lists

Lists should not be designed using simple indents but must be defined by using the built-in
Bullets or Numbering function. Word offers some formatting automatisms: When you type 1, a
period, a space, and some text, then press Enter, Word automatically starts a numbered list for

you. Type * and a space before your text, and Word makes a bulleted list.

Dokumentl - Word

EINFOGEN ~ ENTWURF  SEITENLAYOUT ~ VERWEISE  SENDUNGEN  UBERPRUFEN  ANSICHT A

£ | 2| || pasbeond] asBbede Aa

Ale™ | (e

D alibri (Texth = |11 <A A |Aa- | A

| . o
e KU -axx, x| A% A~

Aktuelle Liste
{1 Schyiftart [

1.Klicken Sie auf den Reiter
Start.

Forma

1
a

Listenbibliothek 1

Ohne a) 11114
- - - - i TEILLA
2.Klicken Sie auf Listen mit mehreren Ei
Ebenen. z o ERRERRRR]
schait 10T 1 1o

To switch levels within nested lists, you can mark the text and use the Increase Indent option or
click the desired command in the Multilevel Lists options.

BHS O- DokumentL - Werd
START | EINFUGEN  ENTWURF  SETENLAVOUT  VERWEISE  SENDUNGEN  UBERPRUFEN  ANSICHT  ADD-INS  PDF

e 2.Klicken Sie auf Einzug verkleinern FS“““E” z

X
D o Calibri (Texth = |11 <A A | Al | A

) oder Einzug vergréfern zum andern der ficErsetzen
Listenebene.

Ce |
Einfi | A -
infagen o | F K U -axx x|[A-W-4A- & Markieren = |

Zwischenablage & Schriftart [ Absatz ] Bearbeiten [

1. _Liste Fbene 1
~=—1.Markieren Sie den Text welcher

111 Tste Ebene3 auf eine andere Listenebene soll.
1134, Liste Ebene 4
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Please note:
Multilevel lists should be scrutinised with particular care in the final PDF, because, errors are

likely to occur during conversion.

3.5.5. Tables

Only genuine data tables created with the built-in Table function in Word can be properly
processed in terms of accessibility. Each table cell must be individually controllable by keyboard

or mouse and have visible continuous gridlines.

To create a table, go to the ribbon’s Insert tab. Click on the Table button and set up columns and
rows in the Table menu.

BHS O
START

B Deckblatt -

7 Leere Seite

mm_mltKlicken Sie auf den Reiter Einfiigen. L

T SmartArt & Link

- 2.Klicken Sie auf Tabelle, [ " Tetmeie

o | ZJQuerverweis
e

"— Seitenumbruch

Apps | Medien Link Kommentare

Please note:

Designing accessible tables takes some conceptual forethought. Complex tables are often not
very user friendly, as authors tend to overload the grid space with too many facts and inter-
related data. Consider breaking complex tables into a several smaller tables. Besides, complex
tables can be difficult to make accessible in PDF, i.e. they often require massive technical
remediation in Adobe Acrobat DC.

Tables should be used only for the purpose of setting out tabular data. For general page layout
use the layout tools provided by Microsoft Word.
3.5.6. Alternative text for visual content

Images, such as pictures, icons and graphics must be provided with alternative texts. It is not only
important that they have an alternative text, but that the alternative text is a true equivalent to the

content shown. In a nutshell: Keep it as short as possible and as detailed as necessary.

An illustrative, German-language guide to the creation of meaningful alternative texts is provided
by the online resource BITV-Lotse (Link see Chapter 7.3.4).
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> 5 N N . - s,
o E © 2.Wihlen Sie den Reiter Format aus. ot 5 R
START EINFUGEM ENTWURF SEITEMLAYOUT S PDF FORMAT Erik Rauc... =
= N L# - L ene nach vc = - ™ -
3.Klicken Sie auf Format = A I A 11T
rie| formatieren. [ i .
pati = ol Auswahlbereich | 4 Klicken Sie auf Layout und
Anpassen Bildformatvariagen Anardnen Eigenschaﬂen.
Grafik forrifatieren X

1.Wihlen Sie das Bild aus welches den Alternativtext erhalten

soll. H O

[ TEXTFELD

fas]

[E]

4 ALTERNATIVTEXT
Titel &
Titel des Bildes
Beschreibung

Hier kommt der Alternativ Text rein.

In Word, alternate text can be added to images as follows: right-click on the image and select
Format Picture. Within the tab Layout & Properties >> Alt Text you can type in the alternative
description; please use the Description box; the Title box is not relevant in terms of accessibility
and does not require input. Alternatively, you can access this function via the Format ribbon>

Format Picture > Layout and Properties.

Please note:

Screen readers, i.e. assistive technology for users with limited vision by default identify and read
the type “image” ahead of the actual alt text. Therefore, the alternative description should not be
prefixed by expressions like “Image:” or “This figure shows”.

2 - " N N BILDTOOLS
2.Wabhlen Sie den Reiter =

D FORMAT
Format aus.

= = = =] =1 E;;E\Idrahmen'
— e a 2 &4 Bildeffekte -
ﬁ 3.Wahlen Sie Zeilenumbruch aus.

=

Ebene nach vorne [T ay

- Els Auswahlbereich “hDr

5% Bildlayout ~
— Bildformatvorlagen [F] A Mit Text in Zeile I
\‘é‘l-l‘ 20 3 41 5B T -E-\“5‘|-1:‘|-11-\‘12-|-1}-\‘14‘Eguadmt ‘l
= Passend
= Transparent
|1.Wéhlen Sie das Bild aus. E Obenund umen
= Hinter den Text
= Vorden Text
4 Wahlen Sie Mit Text in Zeile

aus.

T Weitere Layoutoptionen...

Als Standardlayout festlegen

In the Layout ribbon, choose In line with text to make sure the image is correctly displayed and

anchored within the logical reading order of the text.

3.5.7. Creating tables of contents

For the sake of accessible organisation, it is particularly important to use suitable headings styles.
The paragraph styles Heading 1, Heading 2, and so on, are central to the document’s structural
design, since they work automatically with multilevel list numbering, tables of contents and cross-

references.

For creating a professional table of contents, use the automated function provided by Microsoft

Word. Go to the References tab on the ribbon >> click Table of Contents. The Automatic Table
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option uses your predefined headings to create an interactive table of contents, which represents

an important navigation aid in the resulting PDF document.

3.6. Using the Accessibility Checker

Barrierefreiheitsprifung
Priufungsergebnisse

FEHLER

4 Fehlender Alternativtext
Bild 2
Grafik 25
Grafik &1
Grafik 43
Eild 3
Grafik 24

WARNUNGEM

> Unklarer Linktesxt (61)
I Objekte nicht "In Zeile" (41)
I Wiederholte Leerzeichen (16)

TIPPS

4 Leserichtung priifen
Tabelle
Tabelle
Tabelle
Tabelle
Tabelle
Tabelle
Tabelle
Tabelle

Weitere Informationen
Griinde fiir die Behebung:

Alternativtext unterstitzt Benutzer beim
Verstehen von Informationen, die in Bildern

Art der Behebung:

und beheben Sie sie, damit Personen mit
Behinderungen auf [hr Dokument zugreifen
kdnnen.

und anderen Objekten bereitgestellt werden,

-

Wihlen Sie alle oben aufgefiihrten Probleme ayf

3.7. Converting to PDF

The built-in Microsoft Office Accessibility Checker can help you check
if you have addressed all the aforementioned accessibility issues

during the authoring process.
o Click File> Info > Check for Issues
o Select "Check Accessibility" from the drop-down menu

In recent versions of Microsoft Office Word, the Accessibility Checker

is located visibly in the Review ribbon (Review > Check Accessibility).

The Accessibility Checker task pane opens next to your main content
and presents a list of potential accessibility errors and their

explanations, warnings, and suggestions on how to address them.

Under Inspection Results, you can now select each issue to see
information on how to fix it. A Under Additional Information you are

directed to the inaccessible content in your document.

Please note:

As the accessibility checker does not conform with PDF/UA, it is not
meant as a substitute for the PDF/UA check (see Chapter 7). It can
be useful, though, in identifying and resolving issues in the source

document.

You can use Word to save the document as a PDF file or create the PDF with the Adobe Acrobat

add-in (recommended). To make sure that all accessibility-related preparations are properly

transferred from the source document to PDF, some application settings must be defined before

converting.

In Office 2013, select File >> Export >> Create PDF / XPS Document. Before saving, click the

"Options" button below and select the "Document structure tags for accessibility" option. Click OK

to proceed with saving the document. A PDF with structure tags will then be generated.
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Optionen ?

B}
! Aktuelle Seite

Auswahl

O Seiten)  Von: [4 2| Bis |4 2
Was veraffentlichen

(® Dokument

Dokument mit Markups

Nicht druckbare Informationen einschlieken

|:| Textmarken erstellen mithilfe von:
® Oberschriften

& Extmarken
f#| Dokumenteigenschaften
Dokumentstrukturtags far Barrierefreiheit

[[] 150 19005-1-kompatibel (PDF/4)
Text als Bitmap speichern, wenn Schriftarten nicht eingebettet werden konnen

|:| Dokument mit einem Kennwort verschldsseln

For better results in terms of structure tags quality, use the Adobe PDFMaker add-in to convert
the source document to PDF.

PDFMaker is a feature of Adobe Acrobat that operates with Microsoft Office and other word
processors. When you install Acrobat Pro on your operating system, PDFMaker controls are
implemented in the workspace of the source application. For Windows, many familiar source
applications add both the Adobe PDFMaker toolbar and the Adobe PDF menu.

To check the application settings, go to the Acrobat ribbon and select Preferences. In the Acrobat
PDFMaker dialog box, check the boxes Enable Accessibility and Reflow with tagged Adobe PDF
and Create bookmarks. In the Bookmark tab, you enable the Convert Word Headings to

Bookmarks option.

Then the accessible PDF document can be created by clicking Adobe PDF> Convert to Adobe
PDF.

To export a PDF, go to the Acrobat ribbon and select Create PDF or select File> Save as Adobe
PDF.

Please note:

Neither the Word function “Export with tags” nor the Acrobat PDFMaker plugin produce PDFs
with a PDF/UA-compliant tag structure. Post-processing and remediation in Adobe PDF are
indispensable — but the better your Word document is structured and semantically enriched, the
less effort needs to be taken afterwards to bridge the gap to PDF/UA.

Meanwhile, several competitors in the market (see Chapter 8) have come forward with software
solutions whose conversion engines come closer to translating Microsoft Word styles and settings
to technically PDF/UA-conforming PDF structures, which significantly reduces subsequent

remediation work in Adobe Acrobat.
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4 PDF remediation in Adobe Acrobat DC

4.1. Getting started with Adobe Acrobat DC

Adobe Acrobat DC offers a number of useful tools and views for remediating PDFs. The following
instructions are limited to the basic set-up of the work environment needed to rework

accessibility-related aspects.®

41.1. Tools center

The tools center contains all the tools available in Acrobat listed by categories. Tools that you use

for remediating PDFs can be added as shortcuts to the right pane (see screenshot below).

Q search tools
PDF/UA Workflow
@ Accessibility
Create & Edit
&2 EditPOF
‘ﬁ = e Organize Pages
Ly 0= > — .
Print Production
Create PDF Combine Files Organize Pages Edit POF Export PDF Enhance Scans Add Rich Media
5 Enhance Scans
(7@ [~ [oen |- o [ e (7 - e TEE

B Prepare Form

B optimize POF

Share & Review

N ara ,
Share Send for Review Comment Stamp Compare Files Measure

[Aga |- add [~ open = [hga |- [open [+ Add [~

Forms & Signatures

che o

repare Form Adobe Sign Certificates

Protect & Standardize

Tools needed for PDF remediation:
e Accessibility
o Edit PDF
e Organise Pages
e Print Production
¢ Enhance Scans

e Prepare Form

% For information on the Acrobat DC interface please refer to the Adobe website:
https://helpx.adobe.com/acrobat/using/workspace-basics.html
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e  Optimize PDF
e Compare Files

Shortcuts can be added by clicking the Add button or by dragging the tool to the right pane.

Tip: For the accessibility workflow it is recommended to create
PDF/UA Workflow

@ Full Check your own customized tool collection. It allows you to quickly

u e k
=, _ access the tools you need during the remediation process. The
= Reading Order
Acrobat User Guide website offers a step-by-step introduction on

% Preflight
R how to create custom tools.'®
g Link -
. Full Check: This feature provides an automated way to check the
;> dit
L -

Al cosemer basic technical accessibility of a PDF file. Please note though that

this check does not cover all PDF/UA requirements (compare
Chapter 7.2).

E Set Alternate Text

R Autotag Document

Reading Order: This tool offers a useful visual approach for

assigning basic tags to content. (see Chapter 4.2 ff).

Preflight: Useful for embedding fonts, fixing structural problems and adding the PDF/UA
Identifier (see Chapters 4.4 und 7.1.1).

Link: With this tool you can create, or edit accessible, active links for URLs and email

addresses (see Chapter 4.3.6).
Edit PDF: Here you can replace, edit, or add text and images.
Add Bookmark: Creating and editing bookmarks (see Chapter 7.3.5.)

Set Alternate Text: this tool guides through all images present in the document and allows to
enter alternate text to one after another. Decorative images can be defined by a checkbox
(see Chapter 3.5.6 and 7.3.4).

Autotag Document: In case of an untagged PDF, this tool automatically builds a tag tree based
on a prior analysis the page elements present. However, it cannot always correctly interpret
the structure and reading order of complex page elements, so that manual verification and

remediation are mandatory.

10 https://helpx.adobe.com/acrobat/using/workspace-basics.html#custom_tool
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4.1.2.

Navigation panels

On the left side of the program interface there is the navigation pane with easy access to

different navigation panels, which provide various functional tools and options for editing the

document.

By default, the navigation panel only contains a selection of available toolbars. For the process

of making documents accessible, only the first two tools are needed.

(=

N
@

(1
Lo

[ Page Thumbnails: in the options menu of this tool, individual pages can be
replaced and inserted; and the tab order can be adjusted to parallel the document
structure (see Chapter 7.3.3).

W' Bookmarks: Existing bookmarks are displayed here, new ones can be added and
edited (see Chapter 7.3.5).

To add more tools that are vital to establish PDF accessibility, go to the acrobat menu on top

and choose View >> Show/Hide >> Navigation Panes.

In Acrobat DC, you can also just right-click an empty space in the navigation pane and select

the following three navigation panels: Content, Destinations and Tags. The icons of these then

appear in the pane below the default panels.

DD OO O

I Content: With this panel, all content objects can be edited. This can be helpful for
selecting items for manual tagging or for correcting reflow errors (see Chapter 7.3.9).
However, you should be familiar with PDF structure before you change anything,
because editing content objects can possibly damage a PDF. "

Destinations: This panel can be useful to set and manage larger numbers of

internal reference links in table of contents etc.

© Tags: This panel is the primary tool in Acrobat for viewing, adding and editing tags
in the document’s tags structure tree (see Chapter 4.2 ff.). Also, you can move tags,

organise them into a hierarchy, add individual properties and attributes, etc.

Once you have made these basic settings, your Acrobat DC workspace is ready for PDF

editing.

" More details on the content panel can be found in Adobe’s Acrobat User Guide:
https://helpx.adobe.com/acrobat/using/editing-document-structure-content-tags.html
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4.2. How to create a semantically correct document structure

A correct document structure helps all users better understand the content offered. What's

more, a syntactically and semantically correct document structure enables users of assistive

technology to skim through the document, to skip content and jump to desired passages in the

document by using specific commands.

Tags form structural frameworks that provide the basis of an accessible PDF document.

Screen readers, for instance, rely on well-structured documents as they interpret tags for

speech output.

A PDF/UA-1 compliant tag structure (based on PDF specification 1.7) needs to obey the

following semantic rules'?:

All tags are arranged in a tree structure with the <Document> tag as root element. All

further tags are contained in the hierarchy levels below the root tag.

Tagging must use structure elements that are appropriate for the document’s content

structure, e. g.:
o A heading must be marked as heading.
o A table must be tagged as a table.

o Alist must be tagged as a list.

Content that is not relevant for the document’s meaning must not be included in the document

hierarchy but must instead be tagged as Artifact. Typical examples are running headers and

footers, page numbers, and background images (decorative images).

Structure elements must be arranged in logical reading order.

Content must be tagged appropriately if the intended information is not otherwise

accessible because of the content’s colour, format or layout.

Text represented in a graphic requires the Alt attribute with an explanation if it does

not contain text in a natural language (e.g. font or script samples).

Images must provide alternative text; image captions must be marked with a

<Caption> tag.

Links must be accompanied by a suitable Link annotation.

2 A good breakdown of all the requirements is presented in a whitepaper on PDF/UA by PDFLib:
https://www.pdflib.com/fileadmin/pdflib/pdf/whitepaper/Whitepaper-Technical-Introduction-to-PDFUA.pdf#page=3
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e Only a single <Figure> tag must be created for groups of graphical elements which

logically belong together.

e Footnotes, endnotes, note labels and references to locations within the document
must be tagged as <Note> or <Reference> as appropriate

e When an image contains words, the text displayed in the typographical image must be
entered in the Actual Text box in the Object Properties dialog / tags tab.

4.2.1. Headers and footers

Headers and footers often contain important information that all readers should be able to
perceive. However, when such contents are read by screen readers, users may struggle to

distinguish main page information from the content in headers or footers.

Headers and footers may, of course, be included in documents, but if the information is
redundant (such as pagination, information on author or organisation or logos), it is
recommended to mark those repetitive elements as background information. This means they
should not be included in the regular tag structure, but rather be tagged as an Artifact. For

more details on artifacts see Chapter 4.2.3.

Other content placed apart from the main text body such as annotations, info boxes or
footnotes should be arranged in the tag tree in a way that the logical sequence of information
is maintained; i.e. footnotes elements should be placed immediately adjacent to their

associated reference elements.

4.2.2. Editing tags

The automatically generated tag structure can and should be reviewed and subsequently
reworked in the Tags panel.

If a tag is not appropriately assigned to a content item, it must be corrected so that assistive
output devices can correctly identify and interpret the information. For instance, if a portion of
text designed as a headline in the original document carries the mark-up of a body text
paragraph, but provides significant hierarchical information to the user, the associated tag

must be changed to a heading tag.

Federal Ministry for the Environment, Nature Conservation and Nuclear Safety (BMU)



User Guide: Creating Accessible PDF Documents

Object Properties B To edit a tag, right-click the context menu and

picl] ™o [okg | select Properties. In the following dialog, the

Type: |Paragraph v

tag properties can be edited; e.g. a a

Division A

Title: | pacument

Faue Paragraph tag can be changed into a Heading

Heading tag .

Actual Text:

Alternate Text:
Heading Level 2
Heading Level 3
o |Heading Level 4 v

To do this, go to the Tag tab and select the

desired tag type from the drop-down menu.
Click on Close (or use the shortcut ALT + C) to

confirm the selection and check whether the

<

Language:

Edit Tag... Edit Attribute Objects... Edit Attribute Classes...

tag type has now been updated in the tag tree.

Please note:
In the tag tree you will only find standard tag names, while in the properties Object properties
dialog the general language description is listed (i.e. <H1> versus "Heading level 1"). For an

overview of all standard tag types and their descriptions, see Chapter 6.

Alternatively, tags can also be renamed immediately in the tag tree. Select the desired tag and

press F2 or double-click to edit it. Now enter the desired tag name.

Please note:
The tag name must be entered exactly as prescribed by the PDF specification in order to have

role assignments function correctly. Make sure you pay attention to the upper and lower case.

4.2.3. Artifacts / Hiding non-relevant content as background

A core aspect of accessibility in PDF is the separation of relevant content from elements that
fulfil layout purposes only. Such irrelevant page elements include dividing lines, frame borders,
empty lines, illustrative elements or decorative pictures and ought to be treated as background
information. This also applies to content organised in running headers and footers, i.e. content
that repeats on every page, such as page numbers, author or company name, etc. If included
within the linearized output of assistive technology (AT), these elements confuse the user and

distract them from the main content.

To ensure that only relevant content be interpreted by the linearized output of assistive
technology (AT), all irrelevant or purely decorative elements should be hidden from the
structure elements tree and labelled as “artifacts”, i.e. background information. Artifacts are

not read by a screen reader.

Important: the PDF/UA standard requires ALL contents of a document either to be tagged

with the appropriate tag or be marked as “artifact”.

There are two ways to do this in Acrobat Pro DC.
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A) Via the context menu of a specific tag within the tag tree v @ <Fgure>

=

<P New Tag...

In the Tags pane, locate the decorative content you want

o
IV

Cut

to hide, right-click the content tag and choose Change
Tag to Artifact....

<P Delete Tag

<P Delete Empty Tags
<P> Reading Order (x)

In the ensuing dialog box, define the type of Artifact, e.g.

Find Tag from Selection

Create Tag from Selection

Layout and confirm with OK.

Find...

(v v v v v v v v v
- & & &= & & & & & &
S
%

Change Tag to Artifact..

Then remove the remaining empty tag shell from the tag

Copy Contents to Clipboard

U anona
28 898 E

tree. Repeat these steps with all other decorative

Edit Class Map...

~

=A
o
b

elements. Edit Role Map...

<P

<TQ) Tag Annotations

B) Use the Reading Order tool

<H1 « Document is Tagged PDF

p
P Show in Content Panel

In the main document pane, select the page element you <

« Apply Role Mapping to Tags
P> v Highlight Content

want to hide and open the Reading Order tool. In the

<P Properties...

vV v v v v v
| = =2 & =2 @ @ =

Reading Order tool's dialog box, click the Background /
Artifact button.

The tag disappears from the tag tree and is no longer highlighted as tag in the main
document pane. To check whether the artifacted element really has disappeared from the
tag tree, highlight the content in the main document, and in the Tags pane select Find
Tag from Selection from the options menu. The message that the selected content was

not found confirms that the element has been turned into an artifact.

If by accident you have defined a relevant element as artifact, you have several options to turn
it back into a tagged item:

A) Select the content in the document. In the Tags pane, right-click the context menu on the
preceding tag in the tag tree and select the Create tag from selection option. It is
advisable to create the tag in a position that is close to the location of the accompanying
content. This makes it easy to later check the reading order of the content and adjust it if

necessary.

B) Select the content in the document. Use the Reading Order tool and select the button for

the desired structure element tag.

C) Inthe Tags pane, right-click any tag and select

the "Find ..." command. In the dialog box Find: | Atfacts v

"Artifacts" should already be pre-set. Now select
Type: Mone

the Search Document below and click Find.
(®) Search Page (O) Search Document

All non-textual elements (artifacts) will be displayed Find Tag Element Close

in the document one after the other and highlighted

with a blue rectangle in the document pane. Click Find Next until you reach the desired
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element. Then select the Tag Element button. Now you can assign the desired tag type to the

artifact.

Please note:
In the new PDF 2.0 standard, artifacts / background elements have their own tag type
Artifact.

4.2.4. Adding tags to a document

When you start editing a PDF document, you should first make sure that the document

possesses a tag structure.

To check if tags are present, go to the Tags pane. A window will open and display existing
tags. The tree can be expanded with the arrow signs. If there are no tags, the message "No

tags available" is displayed.

Please note:

Adobe Acrobat DC offers the option to "Add Tags to Document". Adobe Acrobat DC then
interprets the displayed content and automatically "recognizes" the tag structure of the
elements. However, this is not recommended as standard procedure because the tag
structure automatically generated by Acrobat DC does not meet the requirements for a
semantically correct tag structure according to PDF/UA standard and requires extensive
remediation on the tag tree. Typically, the document should already be prepared and exported
from authoring software such as MS Word or Acrobat InDesign so that it comes with tags. In

Adobe Acrobat DC only minor remediation steps should be necessary (see Chapter 4).

4.3. Tags for specific types of content

4.3.1. Headings

Structured headings elements provide users with a better understanding of the information
and its presentation in the document. In addition, headings make it easier for users to find their
way around as they allow them to “scan” content and quickly access information of interest. A

heading should therefore be descriptive and unique, i.e. only appear once in the document.

Sections such as glossaries and tables of contents should also have headings. This allows
users of screen readers to skip these sections as needed without having to listen to all of this

content.

Content should be organised in a logical and meaningful way (This is something that should
be considered right at the start of the authoring process). Headings must be appropriately
applied to reflect the conceptual hierarchy of chapters and subordinate chapters. In PDF 1.7,

heading levels 1 to 6 (<H1> - <H6>) are available for structuring. PDF/UA-1 requires heading-
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levels not be skipped. If you need to add <H1>-<H6> tags to your PDF, you may want to open

the Reading Order Tool and click the button corresponding to the appropriate heading tag.

Please note:
PDF 2.0 allows heading levels below the 6th level, i.e. H7-H12.

Document title # Heading

A title is information representing the normal means of referring to the document. Titles can be
present as both metadata entry (in the Document properties) and page-content. As such it can
be accessed by screen readers: displayed as window title (as required by the PDF/UA

standard), it is read out whenever the file is selected by AT, e.g. on a desktop.

Even though PDF 1.7 has no structure type matching the concept of “title”, it is recommended
document titles appearing on page 1 not be structured with <H1> unless it is the only <H1> in

the document.”®

Since the document title itself is usually not part of the document’s heading-level hierarchy,
(e. g. it does not appear in the table of contents), it is admissible to simply tag it as a <p>
paragraph. This also corresponds to the default formatting in Word: if the "Title" style is used

for the document title it results in a <P> tag in the converted PDF.

Please note:
PDF 2.0 adds a <Tit1le> structure type for the purpose of tagging document titles.

If for a PDF/UA-1-conforming document you choose to create a custom <Title> structure
element type (which is acceptable), it is recommended to map such structure element types to
<p> to be PDF/UA-1 compliant. That way, upgrading this document to PDF 2.0 / a future
PDF/UA-2 would simply require deletion of this role map instead of reworking the entire

hierarchy of heading levels.

4.3.2. Images / Visual content

All images that are relevant to understanding of the information offered must be tagged as

<Figure>.

To tag figures, you can use the Reading Order tool. Use the left mouse button to drag a frame
around the image and then select the "Image" button in the dialog box.

For some types of images, such as vector graphics, Acrobat DC breaks up the image to many

'3 See the reasoning by Duff Johnson (PDF Association) in his “Tagged PDF Best Practice Guide: Syntax’:
https://www.pdfa.org/wp-content/uploads/2019/06/TaggedPDFBestPracticeGuideSyntax.pdf#fpage=24
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small single image parts. In this case, the picture has to be tagged again as a whole in
Acrobat DC.

Adding alternate text

All content-bearing illustrations must be provided with meaningful alternate descriptions.
Ideally, they should be as clear and concise as possible, but long enough that a person who is
blind or with low vision has the same information that a sighted user would get from glancing
at the picture. The information should be fully usable when graphics or images are not

displayed but replaced by the text alternatives.™

If possible, they shall already be added in the
source document.

If alternate texts need to be added to the PDF,
open Acrobat Pro DC’s Reading tool and select

the picture.

To create the alternative text or edit it, right-

click on the black bar and select Edit Alternate
Text.

v Show reading order panel

Show page content groups 4
Display like elements in a single box Set Alternate Text Y
' Show table cells L\@
+ Show tables and figures Image 1of4 b
Edit Alternate TES
] Alternate text: [ Decorative figure

+ r Clear page structure

PDF Association logo.

You can also add review and set alternative

texts to all images in the document by using SENE LB Sz

the Accessibility tool >> Set Alternate Text e e x

Make sure the alternative text does not repeat information already given in the caption orin

the preceding or following text paragraphs.

Do not use introductory words ("The picture shows ...") and leave out unnecessary details that
are not directly relevant to understanding the key message. Depending on the context,

different alternative texts may be adequate descriptions to the very same image.

* The German-language “BITV-Lotse” offers an illustrating guide on how to deal with alternate text: http://www.bitv-
lotse.de/BL/DE/2_Bestandteile/2 1 Textalternativen/2 1 _a_Bilder/2 1 _a_bilder tabelle.html?selectedTab=1
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For complex information graphics, diagrams, graphs and charts, the key message of the
presented facts or a trend in the development should be conveyed in a concise but clear way.
All important aspects and relations shall be mentioned. This may mean a significant editorial
effort.

Start thinking about concepts of accessible presentation during initial document design in the
authoring application. Ideally, the data presented in a complex infographic should be
additionally provided in an accessible data table below each diagram. Another good approach
is to create an attachment to the PDF document with the longer more detailed description of
the complex image. The image’s alternative text can refer to the corresponding table or
attachment. This ensures that the information conveyed by a complex image is not hidden in a
confusing longish alternate text, but is available to all users alike, regardless of user device or
AT.

If typography is used, i.e. images that represent characters or symbols, the text displayed

must be entered in the object properties’ "Actual text" box instead of as alternative text.

Please refrain from adding alternative text to purely decorative images / symbols. Such
duplicate content considerably impedes accessibility for users of linear representations such
as screen readers. Decorative images, which represent no relevant information or repeat
information already provided in the text content, should be marked as artifact to exclude them
from the relevant content reflected by the structure elements tree. For these artifacts, no
alternate text description is required and desired. Such duplicate content considerably

impedes accessibility for users of linear representations such as screen readers.

If in doubt whether an image requires an alternate description or not, consult the helpful
W3C'’s Alt decision tree.'®

5 https://www.w3.org/WAI/tutorials/images/decision-tree/

Federal Ministry for the Environment, Nature Conservation and Nuclear Safety (BMU)


https://www.w3.org/WAI/tutorials/images/decision-tree/

User Guide: Creating Accessible PDF Documents

4.3.3. Captions

Captions of tables and figure must be tagged with a <Caption> tag. As these elements are
by default mapped to <P> tags during conversion with Adobe PDF maker, these <p> tags

need to be changed to <Caption> (see 4.2.2).

> g <P> In the tags tree <Caption> should precede the
v @ <D= element it captions. According to PDF 1.7 it shall be
v §f <Caption> the first or the last structure element inside its parent

&g Abbildung 2: Das Politikpak structure element.

w4 <Figure> However, the following tag structure has proved to
g Bild (95): B:834 H:605 be semantically useful, too — in terms of associating
v 4 <P> figure elements with their captions and related

information:

= | Quelle: eigene Abbildung

In the tag tree, group the <Caption> tag, the <Figure> tag, and any other <p> tags with
information directly related within a parent grouping structure element such as <sect> or

<Div>.

434. Lists

Lists basically consist of several interrelated list items arranged by means of enumeration
(either by bullets or list-numbering). The semantics must also be reflected in the tag structure

in order to make this content meaningful for all users.

= <L>
Lists are organised according to a tree structure: B <u>
47 <Lbl>
The list (<1>) is the parent element, which consists of several child =
elements, the list items (<L.I>). List elements can only have Labels = <LBody>
¢ Kernobst
(<Lb1>) and List ltem Body elements (<LBody>) as children. B <L
. o B <Lbl>
The label element contains the list item marker, such as a bullet =
point or a list number. The list element text <L.Body> contains the =4 <LBody>
content of the list element. S Steinobst
= O <Ll
Sample List “Obst* (German for fruit) @ <Lbl>
=
«  Pome fruit = <LBody>

. ¢ Beerenobst
+  Stone fruit —

e Soft fruit
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Often, documents contain nested lists, where a list item - O e
contains multiple list sub-items. A nested list must be created B <LI-
as a child element in the LBody element of the list item it & <Loi>
=]
refers to. The <L> tag for the subordinate list must be placed OfLBDd}m
=¢ Kernobst
behind the text of the parent list body element. B <L>
. = O <|I»
Here's an example of a nested list: B <Lbb>
*  Pome fruit -
B4 <LBody>
o Apple ¢ Apfel
= <j <=
o Pear @ <Lbl>
+  Stone fruit il Oﬁfw- .
ody
o Cherry B¢ Birne
= O <L
o Mirabelle = <Lbl>
= -
o Plum =47 <LBody>
. %F Steinobst
. Soft fruit =
oft frui o <>
o Strawberry B4 <L1>
O FahEs

o Raspberry

o Currant

For lists that span multiple document pages, make sure that the list items (<1.1>) that appear
on the following page are placed within the same list as the previous page, so that users can

have related content as such and recognize the number of list items.
Marking numbered lists with the ListNumbering attribute

Numbered lists are lists that use numbers (1st, 2nd, 3rd, I, II, lll) or letters (A, B, C, aa, bb, cc)
as bullets. According to the PDF/UA standard, they must be marked with an attribute value.
Here is how to add the attribute in Acrobat Pro DC:

g |n the <L> tag’s object properties, click "Edit Attribute
e Objects ..." in the Tag tab.

Type: [List

rie: |

Actual Text: ‘

Alternate Text:

o: |

Language: |

Edit Tag. Edit Attribute Objects. Edit Attribute Classes.

N Close
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The Attributes dialog opens.

Attributes

Path: Attribute Objects\
Type: Dictionary

= Attribute Objects
= /Attribute Object 1 <<Dictionary>>
/O /List
/ListNumbering  /Decimal

Change ltem ‘%alate Item ‘ | New Item

Options 0K Cancel

In the Key field, enter ListNumbering (please adhere

to the exact camel case spelling).

In the Value field, enter the value according to your

list numbering (see below).
For Value Type, select Name.
ListNumbering values:

e Decimal-1., 2., 3., 4.
e [owerRoman - i, ii, iii, iv

e UpperRoman -1, Il, I, IV

If no entry saying /Attribute Object 1 << Dictionary >>
exists yet, click New [ltem to create an entry.

Expand the entry /Attribute Object 1 << Dictionary >>
by clicking the + plus button. Select /O /Layout and
click Change Item. Delete the value Layout and insert

the value List instead.

Then select /Attribute Object 1 << Dictionary >> again
and click New ltem.

Key: |ListNumbering

Value: |Decima|
Value Type: |Name @

)4 Cancel

e LowerAlpha - a, b, ¢; aa, bb, cc

e UpperAlpha-A,B,C,D

4.3.5. Creating a table of contents

Tables of contents (<TOC>) help navigate within the document. They are basically structured

like lists, but with different tags.

Please note:

PDF 2.0 does no longer include TOC and TOCI structure elements. This functionality is

going to be covered by the structure tags for generic lists (L, LI, etc.).

A table of contents (<TOC>) consists of table of contents items (<TOCI>). <TOCI> elements

contain the content, e.g. description, leader dots (of present) and page numbers.
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When documents are converted from Word, the TOC’s heading (e.g. “Table of Contents®) are

automatically generated as a part of the TOC, often as the first <TOCI>. This is not standard-

B <H1> compliant and needs remediation, i.e. the tag should be
Gl TOC .
gé <T;CI> dragged out of the parent <TOC> tag, placed in front of
= <Reference> it and changed to a heading structure element.
E|<j <Link>
¢ Uber diese Broschure If the document does not yet possess a TOC structure,
6

& <Verknagfen - OBJR> proceed step-by-step to create the structure shown in

EHG 2T0d | the screenshot above.
= <Reference»
=@ <Link> Create a TOC tag and as many empty TOCTI tags you
¢ 1Einfuhrung: Gewasserbewi
: . BRI need for your table of contents.
 sVerknapfen - OBJR> Click the first empty TOCI tag and select the
B <TOCI> . '
B <ToC> corresponding text of the first table of contents entry.
B <TOCI> Right-click on the tag tree on the left and select "Create
Bf <TOCI> .
ho e Tag from Selection”.

Adding internal references and links to a table of contents

For longer documents, it is recommended to provide the table of contents with links, so that
the user can easily navigate to the desired page by clicking on an entry. PDF/UA-1 does not
explicitly mandate this'®, but according to BITV 2.0 alternative ways to access content shall be
provided. In any case, linked tables of contents in PDF considerably enhance the user
experience. BMU therefore requires accessible PDF documents to have a linked table of

contents in addition to the bookmarks.

When you use styles to format headings and have the table of contents automatically
generated by using the “insert table” function, Microsoft Word usually creates a linked table of
contents that already contains a correct tag structure in the converted PDF, with the exception

of the above-mentioned heading.

Otherwise, the links must be added manually to the table of contents, ideally below a
Reference a tag as shown in the above example. You can do this in Acrobat Pro DC using

references and links (see Chapter 4.3.6) or the “destination” feature (see Chapter 4.3.7).

4.3.6. Links

Internal and external links are often used to ensure that the reader has immediate access to

related information. Active links let you jump to other locations in the same document or to

6 See Duff Johnson’s reasoning at: https://www.pdfa.org/wp-
content/uploads/2019/06/TaggedPDFBestPracticeGuideSyntax.pdf#page=16
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external websites. If you include links in a document, you should make sure that they are

designed to be equally accessible to all users.

Link tags must conform to a certain syntax so that they can be activated by keyboard and
recognised by AT as starting an action. Links must be tagged as <Link>. The <Link>
structure element typically associates content and an actionable link annotation, i.e. the so-
called Object Reference element OBJR. To mark a link correctly, locate the tag of the visible
link text in the Tags pane. Select the parent tag of the of the link text content element and

change its type to <Link> (alternatively, press F2 and rename the tag directly to <Link>).

Please note:
Although most links most likely are bound to visible elements, PDF/UA-1 does not require that

<Link> structure elements enclose content.

To add the OBJR to the link, follow these steps:

Find Elernent = Right-click on the <Link> tag to activate the
N ywr context menu and select the Find ... command.
Artifacts In the dialog box that opens, select "Unmarked

Unmarked Comments

links" in the search field and click Find. As soon
Type: Unmarked Annotations

Unmarked Content

OCR Suspects

Find Tag Element Close

as the desired link is indicated by a blue

rectangle, click on the button Tag element.

Sl M- 0TI RTE e NIy amer Llrmarern i p 1g) paee oy per gl Close
=4 <Link>

< Verkniipfen - OBJR
B http:/www.urmweltdaten. des

and check in the logical tree structure whether the
OBJR appears within the link tag. Although in general

OBJRs may appear at any location within the <Link>
element, for links that span pages, it is recommended that all OBJRs be next to each other in

the logical order.
Link texts and the Contents key

Meaningful link texts help users understand the purpose of the link so they can decide whether
they want to follow the link. The purpose of the link shall be clearly stated by the text of the link
itself or its context (e.g. the sentence that precedes or contains that link). Meaningful here

means short, but precise. General terms such as "see here", "more", "more information" are to
be avoided. If the linked resource is a web page, the title of this web page can be used to

describe the purpose of the link.

In addition to the general requirements for link text deriving from WCAG 2.1, PDF/UA requires
links to have a sort of alternate description as well. This extra information can be useful for
users of AT, since it describes what users will find when they follow a hyperlink. According to
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the current PDF/UA-1 standard, an alternative description of the link destination must be

created in the so-called Contents Key of the <L.ink> tag properties.

Please note:

In the upcoming PDF/UA 2.0 standard, this criterion is expected to turn into a warning,
meaning that link annotations then might no longer be mandatory for conforming PDF. It is
important, though, that the link’s target or function then becomes absolutely clear from the

context or the linked portion of text.

When exporting Word documents with axesPDF for Word or InDesign files with the axaio
Madetotag plugin, the content key for links is set automatically. Otherwise, manual

remediation in Adobe Acrobat DC is required.

Tag Element x| Procedure:
Path: Tag Element A010%j In the Tags pane click the <Link> tag, right-click to
Type: Dictionary
2 Tag Hement ~ activate the context menu and select Properties. In
/1D (ADOODD0D-0000-0000-ADBE-  172074) . . . .
S eyl the following dialog click Tag auf Edit tag...
= [0] <<Dictionary>>
=0 e Click the button New ltem to create the contents
@ /A <<Dittionarys >
/BS  <<Dictionary>» key for the link.
/Border  [Array]
/T [Array]
/Contents  (Further information: www.alpine-region.eu/the-
/P <<Dictionary>> ﬁ'l.ljlj KE}" and 1'.|r3||.|E X

@ /Rect [Array]
/StructParent 580

JSubtype  /Link KE}f' ||: ontents
/Type  /Annot =
/Pg  =<Dicticnary=>
fType /OBIR Value: }\Ainistr}r's website on accessibility
[11 40 v
< >
o EEEEETE New ltem Value Typ E[' String hd

Options Cance

In the Key field, enter “Contents” and select “String” as Value Type. As Value field, enter an
alternative description of what to expect behind the link. For links to web pages, a good
practice to use the title attribute of the target page: you want to make sure that AT users
receive the information "Visit the Federal Environment’s Ministry’s website on Accessibility"

instead of the all-too technical and less informative URL “Visit www.bmu.de/\WS146”.

Then click OK to save your changes.
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43.7.

P S D OO 0D

Lo

Using destinations for internal references

A destination is the end point of a link and is represented by text in the Destinations
panel. Apart from the fact that the concept is recommended when linking across
different PDF documents (which shall not be discussed here), destinations offer

several advantages for internal references, too.

The Destinations panel helps keep track of many references. Destinations can thus
be used for creating internal reference links in tables of contents. Last but no least
destinations help you to narrow down the physical location of the link target on the

target page.

By the way, PDF 2.0 introduces a new concept that allows to create links that directly

refer to tags, which will further enhance universal accessibility.

How to create destinations:

Destinations are relatively easy to create with Acrobat Pro DC. To do this, use the

Destinations panel in the navigation pane. (If it is not yet displayed in your navigation pane,

this is how you active it:

View >> Show / Hide >> Navigation Pane >> Destinations.)

In the Document navigate to the first heading you want to create a destination from. With your

mouse, highlight the complete heading and copy the text to the clipboard. You will need this in

the next step to name the target.

Destinations X
El-@W
.
2 Introduction

5

This document is intended f
(including authors with som

Destinations
=] &

MName Page

W In the Destinations panel, choose ,New
Destination” from the options menu, and
paste the heading’s name from the
clipboard into the name field. In the
destinations panel you now find the title

and the page of the first link destination.

— .
@ i2 Introduction

L

Repeat this step for all headings that are

listed in the table of contents.
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In the second step, the destinations are used for creating the internal links for the table of

contents.
2  Introducti-- - Select the TOC entry for which you want to
Cop“" o _ create an internal link. Highlight the desired
2 . 1 Abo' Copy With Eormatting Ac ) .
link text (usually the complete line of the
Edit Text . . )
2.2 ACCE  Export Selection Ac.. entry including the page number) and right-
ohight T click to open the context menu. At the
2.3 Wha Strikethrough Text I*1 bottom of the list, select Create Link
Add Note to Replace Text In the following dialog box, make sure that
2'4 Synt Add Note to Text ']g . " .
the settings are correct ("Link Type:
2.5 Lool AddBookmark N Invisible Rectangle" and "Highlight Style:
Create Link...
= B None"). As a link action, choose "Go to a

page view" and click "Next".

Ignore the opening small "Create Go to View” window, and instead open the Destinations
navigation pane. By double-clicking on the desired destination, the internal link is automatically

saved. The entry in the table of contents is now correctly linked.

Repeat this step for all other entries in the table of contents.

4.3.8. Footnotes and endnotes

Footnotes and endnotes contain in-depth information about a piece of information in the main
text. In order not to interrupt the main text, the additional information is visually placed at the
bottom of the page or at the end of the document. The visible connection between the running
text and related footnotes is generally established by references labelled with consecutive

numbers.

This relationship must be made clear to all users. Therefore, the footnote content must be
contained in the linear reading order of the document’s tagging structure. For this purpose, the
tag type Note, <Note> is available. Each footnote is assigned a separate note tag. The

<Note> tag may contain a label for the footnote number, links, etc.

There are several options for implementing footnotes in an accessible fashion'”:

7 A detailed discussion on conforming ways of implementing footnotes can be Tagged PDF Best Practice Guide by
Duff Johnson (PDF Association): https://www.pdfa.org/wp-
content/uploads/2019/06/TaggedPDFBestPracticeGuideSyntax.pdf (PDF, 460 KB)
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(a) Text and footnote are associated to each other via a
reference using a <Reference> tag. The associated
footnote is placed directly behind the reference tag in
the tag tree so that it immediately follows the
reference in the linearized reading order. It is
common to place both elements within the parent
<P> tag of the text where the link is located. The

associated <Note> tag must be sorted manually

behind the Reference tag.

The reference tag ideally contains the number in a

adjacent figure).

-ﬂcP)

= Einschrankungen bei der Literaturrecherch
~ O <Reference»
s <';"“ <Lbl=

= 6
o <j <Motex

= (205)
EE Implementing the EU Energy Eff
subordinate label tag (<Lb1>) (see example in the . q <P

= Gesichtete Daten waren dardber hinaus oft

The logical reading order is therefore conveyed by the immediate proximity of reference

and footnote.

(b)  One frequently used method is to connect footnote to the body text by a hyperlink. If

possible, interactive footnotes should be
created in the authoring application (e.g.
MS Word) to minimize post-processing
effort with Adobe Acrobat DC.

When exporting to a PDF from MS
Word, the link to the footnote is
automatically generated in the body text
as a <Link> tag. Remember to add a
contents key to the <Link> tag

afterwards (see 4.3.6).

This approach requires considering the

logical reading order, too. By clicking the

s 1‘| <P
= Zusétzlich zu den GUTS-Simulationen wurden auc
s <j <Link=
= 1
<j Verkniipfen - OBJR

o O <Mote>

s <j‘ <Lbl>
b O <Formulax

=] Mit M= Populationsdichte, r = Populationsw

IO

= (Barnthouse 2004) verwen-det.

)1‘|<P>

link, the user can jump directly from the text to the corresponding footnote. However, it

must be ensured that they can navigate back to the text from there instead of being stuck

at the end of the footnote text.

Putting both tags close to each other as described in (a) helps to maintain an accessible

relationship. The <Note> tag should be placed as closely as possible to the

<Reference> tag, or at least at the end of the same page.
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(c) Alternatively, the bilateral relationship between footnote and body text can also be

established by back-linking. In this case, the footnote must contain a link that leads the

" Cj < Mote> user exactly to the point where they left
the main text body in the first place.
s <j <Lbl=
] Following this approach, the spatial
o <';"° <Link= o .
proximity between the reference link and
=R h the footnote in the structure tree is no
F Verknipfen - OBIR longer necessary.
= | Verweis und ein Ricklink This method is particularly suitable for

endnotes, which by definition are often

positioned at the end of the document at a great distance from the main text.

Endnotes tagging requires a reliable back-linking mechanism in order to be BITV 2.0
compliant. The goal is to avoid a so-called keyboard trap, i.e. to provide the user with the
possibility to get easily back from the endnote information to the very point where they left

the main text.

This procedure is relatively time-consuming. Specialized tools such as axes PDFforWord

provide fully automated support for this approach.

Please note:

When converting from MS Word, all footnotes of a page are automatically recorded in a
<Footnote> tag. This is not standard compliant according to PDF/UA and must be corrected
in Acrobat DC: Each note needs to be put into a separate <Note> tag. In the tag structure
tree, select the content of the footnote’s content and right-click to open the context menu. Click
on "New Tag" and choose the type Note. Then drag and drop the content into the new

<Note> tag.
Adding IDs

According to the current PDF/UA-1 standard, every footnote must have a unique ID. Since this
is not automatically generated during the conversion from Word with the Adobe PDF Maker,

this information must be added in Acrobat DC.

Procedure:

In the Tags pane, click the <Note> tag, then right-click to activate the context menu and
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select Properties. In the Object Properties dialog, enter the ID of the footnote to the box next
to the ID label.

Tag | Farbe

Typ: Motiz

e |

Originatex: |

ol

Sprache:

Tag bearbeiten... | [ Attributobjelte bearbeten.. | [ Attriputklassen bearbeiten... |

SchiieBen

Important: IDs must be unique. To keep it simple, it makes sense to use the number of the
footnote as an ID.

Please note:

The next version of the PDF/UA standard (PDF/UA-2) is expected to eliminate this
requirement. In the current standard, however, it is mandatory to assign IDs to footnotes.
When exporting Word documents, the specialised plugin axesPDF for Word automatically sets
this ID. Alternatively, the axesPDF Quick Fix software can be used to set IDs for all footnotes

of a document at once. (see Chapter 8).

Please note:
In the new PDF 2.0 specification the <Note> tag has been deprecated. This functionality

will in future be represented by the new structure element FENote.

4.39. Tables

In electronic publishing, tables are frequently used for two purposes: for layout and for
organizing and displaying related data. In terms of accessibility, only the latter is admissible:
Tables should only be used to represent content whose semantics are specifically defined by

representation in a matrix of rows and columns.
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o E Here are some basic instructions for creating accessible tables in
<Table=
EHEE <TR> PDF documents:
EH <TH>
S <TH> Make sure that your data tables are tagged with the appropriate
il table structure elements to allow reflow when resized.
B <TH>
BEH <TH> Tables consist of table rows <TR>, which in turn contain table data
BEH «<TR>
B7 «TD» cells <TD> or table headers <TH>.
B «TD=
EH <TD» Several table rows form a <Table>. If other tags such as <Span>
e <TD> happen to be at the level of the table rows <TR> or table cells
BH «<TD>
EEE <TR> <TH> <TD>, they must be removed from the tag structure or
=4 <TR> declared as artifacts.

Tables spanning multiple pages are structured as a single table. <TH> cells in repeated

header rows or columns (e.g., in tables that span multiple pages) are marked as artifacts.

Depending on the quality of the source document, tables may need to be manually remediated
in Acrobat Pro DC. To do this, select Tools> Reading Order. To edit, select the table or a
desired cell in the document with your mouse. Now, right-click the Table Editor option to make
the adjustments, e.g. make the selected cell a header cell or a common data cell.
Alternatively, the table editor can also be opened by right-clicking on a <Table> tag in the

structure elements tree.

Table header cells must be related to their associated data cells. This gives the screen reader
important information for orientation, where the corresponding data that is associated to this
header cell can be found. The so-called scope of a header cell can be specified in the table

editor. Possible settings for scope are Column, Row, Both or None.

: ‘ Shacorfeedn | In the given example the
Source of energy cg;;iiltls?n VEEEd_m Number of ‘ | Feesin suhsidies for eco-e- H ‘?‘éigai?\e
MW * Lcentikwh cell labelled “Installed
Type

Small-scale itv i "

il ) | isemirﬁeu scape: [Cotumn s . capacity in MW” is a table

stations (subsidized) ata Cel .
header cell. The associated

Other green 2306 5 Attributes 11.79

e AL row oo [ data for this header cell

Wind power 1,555 2 coturmn span: [1 8.34

Biomass, solid 322 2 o[ 13.55 can be found in the column

Biomass, gaseous?® 83 g Associated Header Cell IDs: P 17.79 ) )
below. The correct input in

Biomass, liquid 5.0 = 11.83 P

Photovoltaics 324 ] 2867 the Scope box is therefore

Landfill gas and "C "

sewage treatment 15.8 Cancel 5.42 olumn".

plant gas

Geothermal energy 0.9 0.306 2 0.02 0.0005% 3.85

Total small-scale

TRl S IEn S 2,648 7,140.5 18,482 747.1 12.50% 10.46

and other green

electricity plants
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Installed Feed-in I |_shareoffeed-in ][,
Source of energy capacityin || volumein | | T cePropete x
MW GWh e
Small-scale @© Header Cell Scope: |Row & i
hydropower 342 1,3713 O Daki cell
stations (subsidized)
= Attributes =
er green
electricity plants 230 RO e (| L
Wind power 1,555 2,970.0 Cotumn Span: |1
Biomass, solid 322 2,013.0 o: |
- - = o Assaciated Header Cell IDs: & I
jomass, gaseous .
Biomass, liquid 5.0 0.19
Photovoltaics 324 215.2
Landfill gas and oK Cancel
sewage treatment 15.8 26.0 _
plant gas
Geothermal energy 0.9 0.306 2 0.012 0.0005% 3.85
Total small-scale
gmrg?ﬁ:‘r’zrrsg”“ 2,648 7,1405 18,482 747.1 12.50% 10.46
electricity plants

At the same time, the cell
labelled “Wind power” is
also a header cell; its related
data is found in the row to
the right of the cell.
Therefore, this cell is

assigned the scope “Row”.

For table headers spanning more than one cell the number of row or column spanned must be

defined in the Table Editor. Alternatively, you can set the RowSpan or ColSpan attribute in the

cell’s object properties.

In the following example the header cell ,Premature deaths” spans two columns, namely the

data of the years 2005 and 2010. Thus, in the attributes section, enter “2” into the box next to

the label Column Span.

Table Cell Properties X
* Type
Country Premature deaths ® Header Cell Scope: | Column v
QO Data Cell
ear 2005 2010 )
Attributes
Austria 3,642 3,122 N Rowspan: [1
France 17,916 16,892 Column Span: |2
i 0000
Germany 50,051 41,582 °
Associated Header Cell IDs: %
taly 34,511 32,447
Slovenia 1,011 876
Switzerland 2,978 2,656 o

There are two types of data tables: simple and complex data tables.

For simple data tables, data is associated with only one column header and one row header.
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Example of a simple table:

No. Name Address Date of Birth
1 Max Mdller MiillerstraRe 5, 12345 Muhlberg 01-01-1970
2 Maria Schwarz Hauptstralte 13, 98765 Neustadt 31-10-1965

For complex data tables, the individual data cells are assigned to multiple levels of header

cells at the same time.

Organising complex issues in a single table can impede accessibility for users and assistive
technology (AT) software alike, as interpreting the collected data can prove quite difficult in
such intricate representations. Ideally, a complex table should therefore be split into several

simple tables.

If this is not a feasible approach, Acrobat DC offers options for editing complex tables. Using

the table editor, data cells can be uniquely assigned to all header cells to which they refer.

With the help of the following example table how to manually map table cells into complex

tables using IDs.

Caupoy Fremature deats deathe Tom APMY 105 o]
Year 2005 2010 2005 2010
Austria 3,642 3,122 34,511 32,447
France 17,916 16,892 53,031 53,295
Germany 50,051 41,582 154,382 144,715
Italy 34,511 32,447 98,612 97,193
Slovenia 1,011 876 2,489 2,539
Switzerland 2,978 2,656 10,471 10,225

We look at the data cell to the right of the header cell labelled "Austria", which contains the
value 3,642.

This information refers to several header cells: “Austria” (which in turn refers to the header cell
“Country”) “Premature deaths” and “2005”. Now we use the table editor to assign all header

cells individual IDs.
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} Table Cell Properties x EA
Type
® Header Cell Scope: | Column =
Country Premature d o oata cen [E
Y 2005 Attributes
ear
. - Row Span: |1

Austria 3,642 Cotumn span: [
France 17,916 iD: [P0 2005 5
Germany 50,051 Associated Header Cell IDs: %
taly 34,511
Slovenia 1,011
Switzerland 2,978 cancel

With the Reading Order tool activated, highlight a header cell and open the Table Editor. In the
properties of the table cell, enter a unique ID into the box labelled ID. Choose a clear name so
that you can better distinguish the different IDs from each other later on (here PD 2005 for

“premature deaths” in 2005). The descriptions are for your own orientation only and will not be

used elsewhere. Repeat this procedure for all other headings that you have identified.

R 9 W m - m/y T =l & Y A
Type
O Header Cell Scope: |Mone
@® Data Cell
ALPINE CONVEN
Attributes
Add Table Header ID *
[Country Premature deaths
Header ID: | Year -
ear 2005 2010 Germany -
A ustria 3,642 3,122 France
Economic
France 17,916 16,892 EC 2010
EC 2005 =
[Germany 50,051 41,582 Deaths
Counts
taly 34,511 32,447 o
Klovenia 1,011 876 ADDODDOD—DgOD—ODOD—ADBE— 178455
W—' - - - d cel

Bwitzerland 2,978 2,656

Having assigned IDs for all header cells, you highlight a data cell in the table editor and right-
click to open the Table Cell Properties dialog.

Click the green plus button to open a list of all header cell IDs.

There, you now select all header cells IDs you want to logically associate with the data cell.

They appear in the box "Related heading cell IDs".

Please note:

The order of the connected header cells in the field should reflect a logical reading order. This
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structure would be interpreted by a screen reader as follows: “In Austria, the number of

premature deaths in 2005 was 3,642.”

The reading order should read from bottom to top in the associated header cell IDs pane.

Table Cell Properties x

Type
O Header Cell Scope: |None

@® Data Cell

Attributes

Row Span: |1
Column Span: |1

i0: |

Associated Header Cell IDs: | PD 2005 L'
Deaths
Austria

Country Premature deatfts

ear 2005 2010
Austria 3,642 3,122
France 17,916 16,892
Germany 50,051 41,582
taly 34,511 32,447
Slovenia 1,011 876
Switzerland 2,978 2,656
ble 2.5.3-1 National levels of premature deaths from ambient particulat

| 1 EECE ||

o NowlaWa)
" Table Cell Properties...
- Table Editor Options...
o
u Auto Generate Header Cell IDs N
it

I L= |

|| p= v
IT

Depending on the size of the complex table,
the allocation and assignment of IDs can be
very time-consuming. Acrobat Pro DC
offers a feature that at least automates the
creation of table IDs. With the table editor

activated, right-click on the table. In the

context menu that opens, select ,Auto

Generate Header Cell IDs". Acrobat automatically generates descriptive header cell IDs for all

<TH> tags in a given table. These can then be selected and assigned manually to the

corresponding data cells as already described in the preceding paragraphs.

4.4, Setting the PDF/UA identifier

For screen readers and other assistive devices to identify a PDF document as conforming to
the PDF/UA standard, a so-called PDF/UA identifier must be inserted in the metadata of the

document. This is a small xmp snippet containing the appropriate information.

You can create the PDF/UA identifier in Acrobat DC.

Procedure:

Open Preflight by clicking Tools> Print Production. In the dropdown of the Profiles tab, select

Show All and then the Single Fixup wrench icon.

Expand “Document info and Metadata” and select “Set PDF/UA-1 entry”. Click the “Fix” button.

When prompted, save to a new file name.
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Selection of popular Adobe Acrobat DC functions / commands

Add tags to document

Accessibility Tool > Autotag Document

Tag object properties

Navigation pane > Tags > Right-click menu > Properties

Set default language

File > Properties > Advanced> Reading Options > Language
OR

CTRL + d > Advanced > Reading Options > Language

Reflow (Adobe)
View > Zoom > Reflow OR CTRL + 4

Tab order
Page Thumbnails > Menu > Page Properties > Use Document structure
OR STRG +d

Bookmarks
Navigation pane > Bookmarks > New Bookmark OR STRG + b

Alternate Texts

Tools > Accessibility > Set Alternate Text

Tables

Tools > Accessibility > Reading Order > Table Editor

OR

Navigation pane > Tags > Right-click on Table tag > Table Editor

Automated check
Tools > Accessibility > Full Check

Useful shortcuts:

Collapse entire tag tree: /

Expand entire tag tree: *

Expand highlighted node with children: +

Collapse highlighted node with children: -
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5 Creating accessible PDF documents with Acrobat InDesign

When creating PDF documents from an Acrobat InDesign layout, it is recommended to
execute as many steps and preparations within the authoring tool. This reduces the time and
effort required for PDF remediation considerably. Plus, this allows structural information to
reside in the InDesign file, making updates faster and easier when you need to generate a

revised version.

This requires a somewhat professional command of InDesign and its built-in features for
typesetting and layout as well as a clean and diligent way of working. For more details, please

consult Adobe’s support pages and white papers on InDesign provided online.®

5.1. Styles

For all elements in InDesign, use consistent paragraph styles that are mapped to the
corresponding PDF Export tags. In the Paragraph Style Options dialog, set each style’s
Export Tagging instructions according to its role in the PDF document (heading levels 1
through 6 <H1> to <H6>, normal text paragraphs as <p>, or decorative images or elements as
Artifact. Tables and bulleted and numbered lists are recognized automatically in the export

process and tagged appropriately, provided they have been created using the built-in features.

Important: The language must also set properly (using character styles).

5.2. Logical content order

The content order should already be defined in the InDesign source document. Use the
Articles panel to drag and drop frames and objects and arrange them in the desired reading
order or use the option “Use for reading order in tagged PDF”. Also, images need to be

anchored to the appropriate point within the text flow.

5.3. Alternative texts

Images conveying relevant content require alternative text. Decorative images, in turn, should

be marked as Background / artifact.

5.4. Links

In order to provide accessible navigation mechanisms to the document (e.g. active links and

cross-references, interactive bookmarks and table of contents) these must be created by using

8 Adobe InDesign White Paper: https://www.adobe.com/content/dam/acom/en/products/indesign/pdfs/creating-
accessible-pdf-documentw-with-adobe-indesign-cs6-v3.pdf
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the built-in features, such as the Hyperlinks panel, the Bookmarks panel, the cross-reference
feature.

5.5. File metadata

To meet minimum accessibility requirements of PDF documents, add a meaningful document
title (File > File Info).

5.6. Export

After the document has been properly prepared the InDesign file can be exported (File >
Export) to PDF using the Adobe PDF (Interactive) profile. You also want to make sure you
select the Create Tagged PDF option in the Export dialog box.

For more detailed instructions on creating accessible documents from InDesign please refer to
the support articles on the Adobe website."®

% Mapping styles and tags: http://www.adobe.com/a.ccessibility/products/indesign/mapping.html
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6 Overview of PDF Standard Tags®®

PDF offers several standard tags for content mark-up. These standard tags provide helper
applications with a basic set of semantic and structural elements that are used to interpret the

document structure and to properly format the contents of the document in output devices.

The PDF tags architecture can be extended on demand. Each PDF document can therefore
contain any tag set used by a source application (for example, InDesign styles or XML tags
from an XML Schema). If that is the case, however, it must be ensured that all customized
tags (such as tag names generated from individually named paragraph styles of a source
application) are properly mapped to the semantically corresponding standard PDF tag. Role
mapping is central to the ability of assistive applications to interpret user-defined tags

correctly.

When tags are added to PDF documents according to one of the methods described in this
manual, the role mapping for the document will most probably correct. You can view and edit

the role map of a PDF document by clicking Options in the Tags pane and choosing Edit Role

Mapping.
Tags
o Role Map *
B- ®
H — Path: Document Roles\2Heading (appx)
Type: Name b
@ = Document Roles -
B Delete Tag /1Heading /H1
© Delete Empty Tags /THeading (appx)  /H1
Reading Order () /2Heading /H2
/2Heading (appx) /H2
/3Heading /H3
Eind... /f4Heading /H4
/Algarithm caption  /Figure
/Algerithm caption (appx)  /Mote
Edit Class Map. ) ) )
E———— " (Algorithm step /P v
Tag Annotations
+ Document is Tagged PDF Change [tem Delete [tem Mew lterm
v Apply Role Mapping to Tags ‘Ll\, Changes to a role affect all elements referencing the role,
+ Highlight Content
Options oK Cancel
Properties.

The default tag types are also provided in the New Tag dialog in the Tags pane. A limited

selection is also available as dedicated buttons in the Reading Order tool. It is strongly

20 Standard PDF tags listed in Adobe’s Acrobat User Guide: https://helpx.adobe.com/acrobat/using/editing-document-
structure-content-tags.html#standard pdf tags
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recommended to use the PDF standard tag types as listed in the specification and in the

PDF/UA standard. In addition, standard tags ensure better results if the tagged content needs

to be converted to another format, e.g. HTML, Microsoft Word document, Rich Text Format or

other accessible text formats that can be interpreted by assistive technology.

6.1. Grouping elements

Grouping elements make up the logical structure of the document and are designed for

organizing block-level structure elements hierarchically.

<Document>

<Part>

<Div>

<Art>

<Sect>

<BlockQuote>

<Caption>

A complete document. This is the top-level element of any

structure tree containing multiple parts or multiple articles.

A large-scale division of a document. This type of element

is appropriate for grouping articles or sections

Division. A generic block-level element or group of

elements.

Article. A relatively self-contained body of text constituting

a single narrative or exposition. Articles should be disjoint;

that is, they should not contain other articles as constituent
elements.

- deprecated in PDF 2.0 -

Section. A container for grouping related content
elements. Like ,Division (DIV Class="Sect") in HTML;

usually to be used as sub element of <Part>.

- deprecated in PDF 2.0 -

Block quotation. A portion of text consisting of one or more
paragraphs attributed to someone other than the author of

the surrounding text.

- deprecated in PDF 2.0 -

A brief portion of text describing a table or figure.
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<Index>

<TOC>

<TOCI>

A sequence of entries containing identifying text
accompanied by reference elements that point out
occurrences of the specified text in the main body of a

document.

- deprecated in PDF 2.0 -

Table of contents. A list made up of table of contents item

entries and/or other nested table of contents entries.

- deprecated in PDF 2.0 -

Table of contents item. An individual member of a table of

contents.

- deprecated in PDF 2.0 -

6.2. Block-level structure elements

Block-level structure elements consist of text a paragraph-like presentation. They can be

further divided as follows:

6.2.1. Paragraph elements

<P>

<H>

<H1> - <H6>

6.2.2. List elements

Paragraph. A low-level division of text.

Heading. A label for a subdivision of a document’s content.
It should be the first child of the division that it heads.

Heading levels 1-6. For use in conforming writers that
cannot hierarchically nest their sections and thus cannot
determine the level of a heading from its level of nesting.
According to PDF/UA-1, 12 heading levels are available for

use.

List element tags are specifically designed for organising the content of ordered and

unordered lists.
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<L>

<LI>

<Lbl>

<LBody>

6.2.3. Table elements

List. A sequence of items of like meaning and importance.
Its immediate children should be followed by one or more

list items (structure type LI).

If the list is an ordered list (with the label sub-elements
containing numbers), it requires the ListNumbering

attribute.

Listeneintrag (engl. List Item). Einzelnes Element einer
Liste; ihm kann ein Beschriftungselement (optional) und
muss ein Listenkdrperelement (obligatorisch)

untergeordnet sein.

List item. An individual member of a list. Its children may

be one or more labels (optional) or list bodies,(obligatory).

Label. A bullet point, name or number that distinguishes a
given item from others in the same list or other group of

like items.

List body. The descriptive content of a listitem. In a
dictionary list, for example, it contains the definition of the
term. It may either contain the content directly or have
other block-level structure elements, perhaps including

nested lists, as children.

Table element tags are specifically designed for organizing the content of tables.

<Table>

<TR>

Table. A two-dimensional layout of rectangular data cells,
possibly having a complex substructure. It contains one or
more table rows (structure type TR) as children and may

have a caption as its first or last child.

Table row. A row of headings or data in a table. It may

contain table header cells and table data cells.
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<TH> Table header cell. A table cell containing header text

describing one or more rows or columns of the table.

<TD> Table data cell. A table cell containing data that is part of
the table’s content.

6.3. Inline-level structure elements

Inline-level structure elements contain a portion of text or other content having specific styling
characteristics or playing a specific role in the document. Inline-level structure elements can
be located within paragraphs or other block-level elements and may in turn contain block-level

elements.

<Span> A generic inline portion of text having no inherent
characteristics. It can be used, for example, to delimit a

range of text with a given set of styling attributes.

<Figure> An item of graphical content. Its placement may be
specified with the Placement layout attribute. For purposes
of reflow it shall be moved (and perhaps resized) as a unit,
without examining its internal contents. To be useful for

reflow, it shall have a BBox attribute.
<Form> A widget annotation representing an interactive form field

<Formula> A mathematical formula. This structure type is useful only
for identifying an entire content element as a formula. No
standard structure types are defined for identifying
individual components within the formula. From a
formatting standpoint, the formula shall be treated similarly
to a figure.

<Link> An association between a portion of the content and a
corresponding link annotation or annotations. The link
destination may be located in the same document, within

another PDF document or on a website.
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<Note> An item of explanatory text, such as a footnote or an
endnote, that is referred to from within the body of the

document.

- deprecated in PDF 2.0 -; replaced by new tag FENote

<Reference> A citation to content elsewhere in the document.

- deprecated in PDF 2.0 -

<BibEntry> Bibliography entry. A reference identifying the external

source of some cited content.

- deprecated in PDF 2.0 -

<Quote> Quotation. An inline portion of text attributed to someone
other than the author of the surrounding text. This differs
from the block-level element BlockQuote, which consists of

one or more complete paragraphs.

- deprecated in PDF 2.0 -

<Code> A fragment of computer program text.

- deprecated in PDF 2.0 -
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7 Testing PDF documents for accessibility

With the introduction of the PDF/UA standard and the Matterhorn protocaol, it is possible for the
first time to test PDF accessibility based on a defined technical standard. The official PDF/UA
Conformance Testing Model, also known as Matterhorn Protocol 1.0.22" consists of 31
checkpoints with 136 failure conditions, 87 of which can be tested by software while 47

conditions require manual inspection by a human expert.

The central tool for the technical examination (software testing) is the free PAC 3, which

checks the implementation of the 87 technical PDF/UA criteria.
Since most errors in the PDF can only be corrected in Adobe Acrobat DC, the formal full check
in Adobe Acrobat DC can be useful, too, as a first step to get rid of accessibility problems.

7.1. Automated testing with PAC 3 (PDF Accessibility Checker) 22

PAC 3 is a mighty tool for automatically testing PDF files according to the Matterhorn Protocol
(PDF/UA criteria).

It also features a screen-reader emulator and can be downloaded and used free of charge.?

%, PAC 3 - PDF Accessibilty Checker § - Ea %, PAC 3 - PDF Accesshiity Checker 3 -Ea

| PDF Accessibility Checker 3 O PDF Accessibility Checker 3 O

fersion: 3.0.7.0 About 070 About
Title L Zugang for ale Title @ g7 zu5na foralie
pour .
und von ooy e Ermittiung und ErschlieBung des Energie- und Ressa it e s
Filename Access for all Filename Access for il
fkz_3715_37_601_ressourceneffiziente_software_| fkz_3711_95_313_ressourceneffizienz_unterhaltun
Language Tags Pages Size: Language Tags Pages Size
DE-DE 8207 153 8MB de 11268 214 7MB
Summary Report Summary Report
Sponsors Sponsors
Q{ The PDF/UA requirements checked by PAC are fulfilled. x This PDF file is not PDF/UA compliant.
hesoam romed [warei [raes | | ACCESS = i it [ ]| ACCESS
- v Accessible documents for everyone Accessible documents for everyone.
OS] 8517 0 o of POF Syntax 8607 ° 0
o Fonts 58 [ 0 [P o Fonis 74 0 0 [ 1P
o Content 1178728 0 0 @ ppF o Content 2202304 0 0 @ pDF
(@ Embedded Files 0 (] 0 f’; > @ Embedded Files 0 0 0 "é />
o Natural Language 567652 (] 0 of Natural Language 1053468 0 0
o Structure Elements 5072 (] 0 [) ( Zugang for alle 9 structure Blements 1996 248 1254 () Zugang for olle
5 Aces pour tous . ‘Accds pour tous
o Structure Tree 16414 ] 0 Revane s bl 9 structure Tree 11054 6 5 e
o Role Mapping 15504 (] 0 ‘ Access for all o Role Mapping 12424 0 0 ‘ Access for all
o Alternate Desaiptions 32828 (] 0 $€ alternate Descriptions 24572 0 582
of Vetadata 6 ] 0 pr tsatz o Mvetsdata 6 0 0 pr tsatz
o Document Settings 180 [ 0 oawcevoasTure of Document Settings 114 0 0 oavcrvonsure
-

%] Resuitsin Detai I summary Report as PoF m 7| ResultsinDetal Il summary Report as poF m
Schweizerischer Zentcalverein Schweizerischer Zentralverein
for das Blindenwesen for das Blindenvesen

@ screen Reader Preview %o Logial structure @ screen Reader Frevien %o Logial Structure
T— BITV.... rep— BITV...

2! Matterhorn Protocol (Version 1.02) : https://www.pdfa.org/wp-content/uploads/2014/06/MatterhornProtocol 1-02.pdf

2 Step-by-step instructions for using PAC 3 (available in German only) : https://www.access-for-all.ch/ch/pdf-
werkstatt/pdf-accessibility-checker-pac.html

2 Free download: https://www.access-for-all.ch/en/pdf-lab/pdf-accessibility-checker-pac.html
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The technical check encompasses the following aspects:

e PDF Syntax

Fonts

¢ Content

e Embedded Files

e Natural Language

e  Structure Elements

e Structure Tree

¢ Role Mapping

e Alternate Descriptions
e Metadata

e Document Settings

If a PDF passes the technical check, PAC 3 issues the following message: "The PDF/UA
requirements checked by PAC are fulfilled".

If errors have been detected, the following message is shown: "This PDF file is not PDF/UA

compliant".

By clicking the “Results in Detail” button, will receive a detailed error report. The different error
categories can be expanded for going through the list of error items page by page. Clicking on
an item takes the user directly to the corresponding location in the document. The error report

can also be exported as an accessible PDF document.

Plus PAC offers several other useful views: the document statistics provide an interesting
count of the tags used; the screen reader preview is particularly suitable for the visual check of

semantics (see Chapter 7.3).

The PAC error report is quite detailed and picks up on the technical language used in the
Matterhorn protocol as well as in the DIN ISO standard PDF/UA 14289-1. In some cases,

understanding and correcting the errors may require advanced skills and experience.

In case of doubt, the wiki by the BITinklusiv project offers reliable support. Part of a new
testing procedure (see Chapter 7.3), it provides a list of all test steps, each of which related to
the corresponding PAC error and the associated checkpoint from the Matterhorn protocol.

Detailed bug-fixing instructions are provided for each error type.

All corrections can be performed in Acrobat DC. In addition, specialised software such as

axesPDF QuickFix can help solve rather complex PDF/UA conformity issues, making PDF
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remediation for accessibility purposes much easier (see Chapter 8). For creating, editing and
moving tags in the tag tree, Adobe Acrobat is still the application of choice. Therefore, the PDF
remediation procedure requires a combination of specialist software such as axesPDF
QuickFix and Adobe Acrobat DC.

7.1.1. Fix: Font not embedded

This error occurs some of the fonts used are not properly embedded in the PDF document.

preflight H Open the document in Acrobat DC und activate the

Acrobat Pro DC 2015 Profiles v

B s A ws - | Preflight tool (Tool Center > Print Production >
shoval | 3L L] uffme Preflight). In Preflight go to the Profile tab, choose PDF

5 Object is closer than 1.5 mm to the TrimBox (binding edges are not checked) ~
SO Report PDF syntax issues

* P fups Fixups > Embed missing fonts and click Analyze and

D convert all pages into CMYK images and preserve text information

s from crop marks f[X
pi (bitmaps to 300 ppi)

200 ppi (bitmaps to 600 ppi)

s to 1200 ppi)

This issue can also be solved earlier in the creation

L e e e process. The PDF Maker add-in for MS Word, too,

Fix problems in PDF tagging structure

pob bbb

Flatten annotations and form fields

o v rovi h ibili llow all fon
— Sl provides the possibility to allow all fonts to be

e —— embedded prior to converting the source document to
PDF.

7.1.2. Fix: Path object not tagged

The error “Path object not tagged” needs to be fixed in Acrobat DC. All path objects need to be
changed to artifacts (see 4.2.3).

7.1.3.  Fix: Structural errors

PAC 3 checks whether the tag structure is technically consistent and standard-compliant; e.g.
no <P> tag nested within another <P>, <L.I> occurring in <L> only, correct descending

sequence of headings (<H1> to <H6> without skipping levels in between), tables etc.

Such structural problems can only be fixed in the Acrobat DC Tags panel (see 4.2.2).

7.1.4. Fix: missing alternate description

Alternative text needs to be provided for all images that do not solely serve decorative

purposes (see 3.5.6).

7.2. Automated testing with Adobe Acrobat DC

Adobe Acrobat DC provides a limited automatic accessibility check that helps to search the

document for potential structural barriers. However, it does not
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In the Accessibility tool, select Full Check. In the following dialog window, keep the default
setting unchanged. By clicking on OK the document will be checked. Further information on

the full accessibility check can be found on the Adobe website.2*

All passed checkpoints are marked with a green tick. Failed checkpoints are indicated by red
icons. To fix the faulty elements, expand the list using the + icon and right-click on the desired

element.

In the opening dialog window, either click "Fix" to mend the error immediately (for example,
with alternative texts or tab order), or select the item in the Tags or in the Content pane to

perform the necessary corrections.

Please note:

Even if Adobe’s formal check reveals that no problems have been found in the document,
additional specific aspects must be checked manually (for example, logical reading order,
navigation links and colour contrast). The following Chapter 7.3 "Visual / Semantic Testing"

describes these in more detail.

7.3. Visual /| semantic check

A PDF that passes the PAC checker does not necessarily prove to be compliant to PDF/UA.
Therefore, the technical / formal check by PAC 3 must always be followed by a thorough
visual inspection. It is imperative that the PDF’s semantic quality be reviewed and assured by

a human (supported by suitable software tools).
According to the Matterhorn Protocol?®, this semantic check should cover the following criteria:

¢ Is Artifact tagged as artifact and real content as real content? Does the tag structure

contain all relevant items? (Matterhorn Protocol 01-001 / 01-002)
e Are the assigned tags semantically appropriate? (Matterhorn Protocol 01-006, 09-002)

e Are all non-standard tags mapped in a semantically appropriate way? (Matterhorn
Protocol 02-002, 09-003)

¢ |s information is conveyed by tags or merely by contrast, colour, format or layout?
(Matterhorn Protocol 04-001)

e Are graphics objects other than text objects and artifacts not tagged coherently with a
Figure tag? (Matterhorn Protocol 13-001, 13-005)

2 https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html

5 https://www.pdfa.org/resource/the-matterhorn-protocol-1-02/
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¢ Are captions tagged with a Caption tag? (Matterhorn Protocol 13-003)

In cooperation with the PDF Association, the German BITinklusiv project has developed a
comprehensive PDF/UA test procedure for PDF documents. It encompasses all the
checkpoints from Matterhorn Protocol and is a useful resource to test PDF/UA compliance

beyond PAC 3. The test procedure was published as a WIKI and is available in German only.

7.3.1. Tag tree structure

You must manually check that the order of elements in the tag tree matches the sequence of
content on the page. Also inspect all headings, lists, paragraphs, labels, images and tables in
terms of standard-compliant tags (see Chapter 4.3) and check whether the assigned tags and

role assignments are semantically appropriate as well.
Procedure:

a) Inthe Tags window, select Highlight Content. Then examine the entire tag tree from
top to bottom opening every individual tag and checking whether the contents have

been captured correctly.

b) Alternatively, you can check the tag structure with the screen reader preview of the

PAC 3 or the plug-in callas pdfGoHTML in the structure tags view.

7.3.2. Language

The document’s default human language as well as language switches within the PDF need to
be properly identified. This allows assistive technology and user agents to display characters
and scripts appropriately. Screen readers rely on this information to load the correct

pronunciation rules.

Please note:
Even if the formal check does not report an error, this checkpoint requires human judgment.
PAC 3 and Acrobat Pro DC can only check whether a natural default language has been set. If

the language is appropriate, cannot be determined by software, though.
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To set the default language, select File> Properties (CTRL + d) in the menu. In the Advanced

<] tab, select the language using the drop-down

menu.

For marking a language switch in the document,

that is, to identify other-language terms, phrases,

paragraphs, the language is set directly in the tag
properties. They can be edited using the Tags
— panel.

Select the appropriate tag with the right mouse

button and click Properties. In the Tag tab, the

respective language can be selected by drop-down menu for this day. In a hierarchical tag
structure, a language setting at the first hierarchical level commits the language for all nested

tags. Thus, related portions of text can be assigned a language in one single step.

7.3.3. Tab order

The tab order must be defined so that individual elements can be addressed logically using
the tab keys on the keyboard. Adobe Acrobat DC usually assigns the correct tab order
automatically. However, if PAC 3 or Acrobat’s Full Check returns an error message, the tab

order can be corrected as follows:

; Insert Pages
Page Thumbnails - d Page Properties X
Extract Pages...
= Tab Order
E A @ i O O Bep\ace :‘ages... Actions
Delete Pages... (O Use Row Order

(O) Use Column Order

3 _
Crop Pages... (@) Use Document Structure

Rotate Pages... () Unshecified

. -
2gajipsiionss Choose one of the above options to

set the order for tabbing through
Page Labels... items on a page.

Print Pages...

Gzt

Embed All Page Thumbnails

Remove Embedded Page Thumb)

Reduce Page Thumbnails

Enlarge Page Thumbnails

To make the default settings, select the Page Thumbnails navigation pane. Select all pages by
pressing CTRL + a and right-click Page Properties. In the following dialog window, select the
option Use Document Structure in the Tab Order tab.
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7.3.4. Alternate text

To examine an alternative description, move the mouse over the corresponding graphic; the
alternative text should then appear. Also, alternative texts can be displayed and edited using

the tool at Accessibility> Set alternative text.

7.3.5. Bookmarks

For all users of PDF, bookmarks represent an important guide for finding one’s way about the
document. Users of assistive technology rely on bookmarks to navigate within documents, to
skip unnecessary content and to quickly find the desired information. From a well-prepared
structured source document, bookmarks are usually generated automatically. Depending on
the source format and the way the PDF was generated, however, bookmarks might be

missing.

All documents longer than two pages that are logically and visually structured by headings
require a manual check for bookmarks: Does the PDF contain bookmarks and, if so, do they
provide a complete overview of the contents of the PDF to enable selective targeting of

sections?

Automated software testing is only able to detect whether the bookmark field contains an entry
or not. However, the quality of the bookmarks, i.e. their meaningful description, completeness

and hierarchy, must be verified by a human expert.

Existing bookmarks can be displayed, renamed and sorted in the Bookmarks panel. To add
new bookmarks to the document, left-click on the corresponding portion of text (usually a
heading) and then choose Edit PDF> Add Bookmark (Shortcut: CTRL + b) from the Tools

menu.

The bookmarks should be properly nested to reflect the hierarchical structure of the tags. To
nest a list of bookmarks, select the bookmark you want to nest and drag the icon directly
underneath the parent bookmark icon.

TIP:
Alternatively, bookmarks can be derived automatically from the existing tag structure. With a

well-formed tag structure, this is a clean and effective way of creating correct bookmarks.
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Stractore Elamers x| Open the drop-down menu on top of the

Structure Bookmarks panel and select New Bookmarks

Caption ~
Div
Document

Figure following dialog shows all the tag types

H1
contained in the document. Hold down the

. v CTRL key and select the structure elements

from Structure from the options menu. The

serectAl ClearAl you want specified as tagged bookmarks.

Cancel Usually you may want to use heading tags for

your tagged bookmarks.

After clicking OK, the complete correct hierarchical bookmark structure appears under a new,
untitled bookmark.

7.3.6. Colour contrasts

This checkpoint requires human inspection to determine if the colour contrast between text
and background is sufficient or if the document contains relevant elements that some users

might not be able to perceive.

The combinations of foreground and background colours should be bright enough to be legible
e.g. for users with deficient colour vision or when viewed with a black and white screen. It is
highly recommended to use the free Colour Contrast Analyser tool. (Download details can be
found in the link list in 9.2.)

While contrast is not addressed in PDF/UA, it is one of the basic requirements of WCAG and

BITV 2.0 and therefore obligatory for PDF as well.

7.3.7. Hyperlinks

For URLs to be properly interpreted for voice output, they must be implemented as active links
with Object reference and correct labelling. (The easiest way to create accessible links is to
use the Acrobat function Create link.) Make sure that navigation links do not repeat and that

users can skip recurring links.

You should review manually the navigation links (e.g. in the table of contents and references)
and make sure your document does not contain too many identical links. Also, give users an
option to skip duplicate items; e.g. if the same links appear several times per document page,

include a link to skip the navigation.

7.3.8. Logical reading order

Making sure that the objects in a document are displayed in a logical, linearized reading order

is an important aspect of accessibility testing. Assistive technology render PDF pages based
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on their inherent structure. Therefore, the content’s reading order as presented visibly on the

page must be linearized appropriately for understandable screen reader output.

The logical order of content elements therefore must be checked by a human and corrected if
necessary. This check is performed in Acrobat’s Tags pane. The sequence of the tags in the
tag tree specifies the linearized order in which the content is read and interpreted by the

screen reader.

To check the tag order, select > Highlight Content from the

New Tag... drop-down menu at the top of the Tags window.

Cut Alternatively, right-click on a tag to display the drop-down
menu.

Reading Order (x Whenever a specific tag is selected, the corresponding
Find Tag from Selection position in the document is marked with a blue frame,

Create Tag from Selection

o which allows you to easily compare the tag structure with

. . the structure of the content with the help of mouse or cursor
opy Contents to Clipboard

Edit Class Map.. keys (arrow keys). Expand all tags with + to inspect the

Edit Rele Map... order of all items in the document.

Tag Annotations

5 9§ <P] v Document is Tagged PDF To correct the reading order, drag the misplaced document

> M, Apply Role Mapping to Tags to the correct spot (drag and drop), or alternatively use the
5 <P )

| | v Highlight Content L copy-and-paste commands.
> 9§ <Py Properties...

Meanwhile, a range of useful applications have emerged on
the market, such as the screen reader view in the PDF Accessibility Checker (PAC) 3 or the

tree view in the plug-in callas pdfGoHTML (see also Chapter 8.5).

7.3.9. Reflow

Some people need larger text in order to properly perceive and identify characters. Although
increasing text size is most common, some people with tunnel vision and good visual acuity
may prefer smaller letters so they can see more words at a time. Creators of accessible PDFs
want to make sure that users can resize the text size according to their needs and still be able

to easily view and navigate through the content.

"Reflow" means that the reader automatically adapts the layout of the text even when the font
is enlarged. Line breaks adjust automatically, while decorative elements are not displayed.
Although the document layout may not appear to be very appealing in the reflow mode, linear
content does provide a great relief for visually impaired or physically challenged users as it

allows them to read the content without having to constantly scroll from side to side.

In line with the BITV test accessible content should support the resizing of text to 150 %. This

requires you to manually check that all elements appear in the same logical order as the
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original document, that text reflows properly on all pages, that all content is visible without

overlapping, and that no important information is missing.

Please note:
Acrobat DC comes with its own reflow mode. However, this view does NOT rely on the tag
tree and does not reliably check reading order and presentation. Thus, it should NOT be used

for checking text reflow according to the PDF/UA standard.

For examining tag structure and logical order of a document you may want to use a genuine
screen reader. A recommended product is the free NVDA Reader, which the Swiss Central
Association for the Blind (SZB) has published in cooperation with the Foundation Access for
All (see Chapter 8.7). As NVDA is quite a complex piece of software, it is advised to familiarize

yourself with the handling of the most important features.

Another highly reliable and effective way for checking text reflow is the PAC 3's excellent
“screen reader preview” feature, which clearly displays the document structure according to

the tag tree, allowing for easy visual inspection.

Kurzbeschreibung

a1 Mit dem Vorhaben , Analyse, Bewertung und Politikempfehlungen zur Anpassung nationaler rechtli-cher, planerischer und informatorischer Politiinstrumente zur Anpassung an den Kiimawandel® wur-den
fachwissenschaftliche Vorbereitungsarbeiten, fur die Weiterentwicklung der DAS und die Vorbe-reitung der nationalen Umsetzung der europaisch rategie durchgefuhrt. Der Schwer-punkt des
Vorhabens richtete sich auf die Analyse bestehender Instrumente und deren Weiterent-wicklung, insbesondere:

e I~ « Juristische Begleitung und Vorschlage zur rechtlichen Weiterentwicklung des UVPG sowie ggf. weiterer fur die Umweltprufungen relevanter Rechtsnormen oder Verwaltungsvorschriften im Hinblick
{4 auf die Einbeziehung des Faktors Kimawandel in die Umweltprifungen.

tasks: scientific preparatory work, the further development of the German Adaptation Strategy (DAS) and the preparation of the national implementation of the European Adaptation Strategy. The focus o
the project was to analyse existing instruments and their further development, in particular:

= * legal considerations as to how far adaptation to climate change is integrated into an important component of municipal public services;

Also recommended is callas pdfGoHTML, a free Adobe Acrobat plugin that converts PDFs to
HTML, allowing you to read them in different views. These tools should definitely be preferred

to the very error prone and hardly usable Acrobat reflow mode.
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8 Suitable software and tools

In recent years several new software solutions have been developed to make the creation and
remediation of accessible PDF documents easier and more effective. A major driving force of
this development has been the publication of the PDF/UA standard. This chapter provides an

overview of free and licensed tools available on the market.

axesPDF for Word

axesPDF for Word?® creates accessible, PDF/UA-conforming PDF documents from Word
documents prepared with proper styles and templates. The more accessibility settings are

already predefined in the Word template, the less remediation in Adobe Acrobat is needed.
Additional features:
e decorative elements can be marked as artifacts

o all axesPDF settings can be saved in the Word template

8.2. axesPDF QuickFix

axesPDF QuickFix?” is a licensed tool to check and remediate accessible PDF documents to
make them compliant to PDF/UA DIN/ISO 14289, WCAG 2.0 and Section 508. This software

product provides several useful tools for easily fixing standard accessibility issues.
Additional features include:

o PDF/UA check (using the PAC engine)

e Checking and fixing issues in one step

e Targeted remediation of tag and attribute properties

¢ 1-click-fix buttons (e.g. Link annotations, Note IDs)

o Mapping non-identified glyphs to Unicode and fixing other compliance issues on
PDF/UA that cannot be resolved in MS Word and Adobe Acrobat.

e Marking all non-tagged elements as artifacts (decorative elements) at one go, etc.

% https://www.axes4.com/axespdf-for-word-overview.html

27 https://www.axes4.com/axespdf-quickfix-overview.html
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8.3. CommonLook PDF GlobalAccess

PDF Global Access® is a Microsoft Windows tool widely used by US government agencies to
create, remediate and review accessible PDFs according to several standards such as
PDF/UA, WCAG 2.1, and Section 508 of the U.S. Rehabilitation Act. Coming as an Acrobat
plug-in, the software provides a convenient user interface and various options for effective

editing. It is recommended as a recognized technique in the WCAG 2.0 guidelines.

8.4. axaio MadeToTag

axaio MadeToTag? is a paid plugin for Adobe InDesign CS6 to CC to prepare InDesign

documents for export as accessible, tagged PDF files complying with the PDF/UA standard.

The MadeToTag user interface is based on a seven-step guide, which leads the user through
the creation process of an InDesign file from which to export an accessible, tagged PDF

document.

8.5. callas pdfGoHTML

pdfGoHTML by callas software® is a free plug-in for Adobe Acrobat for converting tagged
PDFs into a HTML representation. The resulting view makes it easy to examine the tagging

structure and text reflow.

It offers several special views, which help to make the document accessible for people with

visual impairments (e. g. contrasts) or dyslexia.

8.6. VIP-PDF-Reader

The VIP PDF Reader®! (VIP= Visually Impaired Person) is a non-profit PDF/UA compliant
screen reader. It comes with various functions to make PDF documents accessible to visually
impaired users as well as to elderly persons or those with cognitive deficits. Users can
navigate documents using the mouse or the keyboard. Documents are displayed in reflow
Users can adjust text size and background colour according to their needs and may display

images and tables clicking on a button.

28 https://commonlook.com/accessibility-software/commonlook-pdf-globalaccess/

2 https://www.axaio.com/doku.php/en:products:madetotag

30 https://www.callassoftware.com/en/products/pdfgohtml

31 https://www.snab.ch/en/hilfsmittel/digital-tools/the-first-pdf-reader-for-visually-impaired-people/
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8.7. NVDA

NVDA3? (NonVisual Desktop Access) is a free screen reader, which has been developed by
an open source project. One of the most popular free screen readers, it enables blind or
visually impaired people to access information on a computer. NVDA converts on-screen
information to speech and Braille script. In addition, it supports various keyboard commands
(shortcuts) for easy handling.® This assistive software itself supports the PDF/UA standard, i.

e. it correctly interprets PDF/UA-conforming PDF documents.

32 http://meinnvda.de/?lang=en

33 http://blog.247accessibledocuments.com/2018/10/18/cheat-sheet-screen-reader-commands-for-jaws-nvda-pdf/
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9 Links and resources

9.1. Legal provisions / standards

e Barrierefreie-Informationstechnik-Verordnung (German directive for accessible
information technology) - BITV 2.0:

http://www.gesetze-im-internet.de/bitv_2 0/ (in German only)

http://www.einfach-fuer-alle.de/artikel/bitv (in German only)

e PDF/UA Standard (ISO-Standard 14289-1):
https://www.pdfa.org/resource/iso-14289-pdfua/

e  German Act on Equal Opportunities for Persons with Disabilities (Gesetz zur
Gleichstellung behinderter Menschen - BGG)
http://www.gesetze-im-internet.de/bgg/index.html (in German only)

e  Web Content Accessibility Guidelines (WCAG) 2.0:
http://www.w3.org/TR/WCAG20/

o EU Directive 2016/2102 on the accessibility of the websites and mobile applications of
public sector bodies
https://eur-lex.europa.eu/eli/dir/2016/2102/0j

9.2. Resources on BITV 2.0

e BITV-Lotse: BITV 2.0 und PDF (in German only)

http://www.bitv-
lotse.de/BL/DE/3 Hintergrundinformationen/3 3 PDF/3 3 pdf node.html

e Colour Contrast Analyser by Paciello Group (freeware)

https://developer.paciellogroup.com/resources/contrastanalyser/

9.3. Resources on PDF/UA

e PDF/UA in a Nutshell:

https://www.pdfa.org/resource/pdfua-in-a-nutshell/

o PDF/UA Reference Suite with sample documents conforming to PDF/UA:

https://www.pdfa.org/resource/pdfua-reference-suite/

o PDF Association: Tagged PDF Best Practice Guide: Syntax:
https://www.pdfa.org/wp-
content/uploads/2019/06/TaggedPDFBestPracticeGuideSyntax.pdf
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e The Matterhorn Protocol 1.02

https://www.pdfa.org/resource/the-matterhorn-protocol-1-02/

e PDF/UA — A Technical Introduction (PDFlib Whitepaper)
https://www.pdflib.com/fileadmin/pdflib/pdf/whitepaper/Whitepaper-Technical-
Introduction-to-PDFUA.pdf

e Video recording: Creating accessible PDF documents with Adobe InDesign:

https://www.pdfa.org/videoaufzeichnung-barrierefreie-pdf-dokumente-mit-adobe-

indesign-erstellen/?lang=de (in German only)

e Common errors and warnings encountered when using PAC 2 - 508 PDF Help Center:

https://taggedpdf.com/508-pdf-help-center/

e YouTube Channel “TaggedPDF”:
https://www.youtube.com/channel/UCT 1tfonDOICSOH3POUM6zKw

e YouTube Channel “Metzessible PDF/UA Series”:
https://www.youtube.com/playlist?list=PLmfVOnJxeSEXsEKv2i20nYMHYuFEcl4fO

. Tools and assistance for PDF/UA conformity check

e PAC 3 (freeware)

https://www.access-for-all.ch/en/pdf-lab/pdf-accessibility-checker-pac.html

o VIP PDF-Reader (free of charge)

https://www.snab.ch/en/hilfsmittel/digital-tools/the-first-pdf-reader-for-visually-

impaired-people/

e Plug-in pdfGoHTML by callas Software (free of charge)

https://www.callassoftware.com/en/products/pdfgohtml

e  PDF/UA testing procedure by BITinklusiv (available in German only)

https://biti-
wiki.de/index.php?title=Einf%C3%BChrung#Vorgehensweise bzw. Durchf.C3.BChru

ng und Korrektur

PDF documents from Microsoft Word

e  Microsoft Support. Make your Word documents accessible to people with disabilities.
https://support.office.com/en-us/article/make-your-word-documents-accessible-to-
people-with-disabilities-d9bf3683-87ac-47ea-b91a-78dcacb3c66d?ui=en-US&rs=en-
US&ad=US
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o  Charles Kyle Kenyon. Understanding Styles in Microsoft Word.

http://www.addbalance.com/usersquide/styleseehtm

e  Microsoft Support. Rules for the Accessibility Checker.
https://support.office.com/en-us/article/rules-for-the-accessibility-checker-651e08f2-
0fc3-4e10-aaca-74b4a67101c1

e  University of Washington: Creating Accessible Documents in Microsoft Word

http://www.washington.edu/accessibility/documents/word/

¢ The National Center on Disability and Access to Education. Accessibility Cheatsheets.

http://ncdae.org/resources/cheatsheets/

9.6. Adobe Acrobat DC

. Adobe Support. Workflow for creating accessible PDFs

https://helpx.adobe.com/acrobat/using/creating-accessible-pdfseehtml

. Adobe Support. Create and verify PDF accessibility (Acrobat Pro)

https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html

. Adobe Acrobat DC User Guide

https://helpx.adobe.com/acrobat/user-quide.html

9.7. Adobe InDesign

e Adobe Support. InDesign / Add structure to PDFs

https://helpx.adobe.com/indesign/using/structuring-pdfseehtml

e Adobe Support. Adobe InDesign Accessibility

https://www.adobe.com/accessibility/products/indesign.html

9.8. Create, test and remediate accessible PDF

e Creation and implementation of accessible PDF:

http://www.einfach-fuer-alle.de/artikel/pdf-barrierefrei-umsetzen (in German only)

e Tipps und Tools fur barrierefreie PDF-Dokumente:

http://www.access-for-all.ch/ch/barrierefreiheit/barrierefreie-pdf-dokumente.html (in

German only)

9.9. Organisations

e BIT inklusiv - Barrierefreie Informationstechnik fiir inklusives Arbeiten:

https://www.bit-inklusiv.de/ (in German only)
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German UPA (German Usability and User Experience Professionals). Working group
for accessibility:

https://www.germanupa.de/arbeitskreise/arbeitskreis-barrierefreiheit/english

German Federation of the Blind and Partially Sighted (DBSV):
https://www.dbsv.org/dbsv-in-english.html

BIK for all:
http://bik-fuer-alle.de/english.html

Bundesfachstelle Barrierefreiheit (Federal Specialist Department on Accessibility):

https://www.bundesfachstelle-barrierefreiheit.de (in German only)

Einfach fir Alle: Initiative by AKTION MENSCH for accessible Internet:

www.einfach-fuer-alle.de (in German only)

Swiss Foundation "Access for All“:

www.access-for-all.ch/en (partly available in English)

PDF Association — PDF/UA Technical Working Group:

https://www.pdfa.org/community/pdf-ua-technical-working-group/
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